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RESUMEN 

 

La presente investigación tuvo como objetivo identificar áreas óptimas para la instalación 

de un relleno sanitario en el distrito de Pichari mediante la aplicación de herramientas de 

Sistemas de Información Geográfica (SIG). El estudio fue de tipo aplicada, nivel 

descriptivo y diseño no experimental–transversal. La población correspondió a la 

totalidad del territorio distrital, mientras que la muestra estuvo conformada por las áreas 

evaluadas mediante criterios técnicos establecidos en la normativa del Ministerio del 

Ambiente (MINAM). Los instrumentos empleados incluyeron imágenes satelitales, 

cartografía temática oficial, GPS de campo, bases de datos geoespaciales y matrices de 

evaluación procesadas en ArcGIS 10.8. Se aplicó la evaluacion multicriterio utilizando 

criterios de restricción y exclusión relacionados con pendiente, fallas geológicas, 

hidrografía, uso actual del suelo, áreas protegidas, centros poblados, vías de acceso y 

aeródromos. Como resultado, se identificaron inicialmente 15 áreas potenciales para 

albergar un relleno sanitario. Asimismo, se estimó un horizonte de planificación de 10 

años (2026–2035), con una proyección de incremento en la generación de residuos 

sólidos desde 19.56 t/día en 2026 hasta 27.18 t/día en 2035, lo que exige un área mínima 

operativa de 9.48 ha para un relleno sanitario de tipo semi-mecanizado. Tras la validación 

en campo, las alternativas se redujeron a dos áreas óptimas que suman 66.38 ha; sin 

embargo, ambas se encuentran entre 46 y 48 km del área urbana de Pichari, lo que limita 

su viabilidad operativa debido a los altos costos de transporte, consumo de combustible 

y tiempos logísticos. En conclusión, si bien se identificaron zonas técnicamente aptas, su 

ubicación distante impide considerar estos sitios como alternativas sostenibles para la 

implementación de un relleno sanitario distrital. 

 

Palabras clave: Sistemas de Información Geográfica (SIG), evaluación multicriterio, 

áreas óptimas, relleno sanitario. 
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ABSTRACT 

 

This research aimed to identify optimal areas for the installation of a sanitary landfill in 

the district of Pichari through the application of Geographic Information Systems (GIS). 

The study was applied in nature, descriptive in scope, and carried out using a non-

experimental and cross-sectional design. The population corresponded to the entire 

territorial extent of the district, while the sample consisted of the areas evaluated 

according to technical criteria established by the Ministry of the Environment (MINAM). 

The instruments used included satellite imagery, official thematic cartography, field GPS 

data, geospatial databases, and evaluation matrices processed in ArcGIS 10.8. A 

multicriteria analysis was applied using restriction and exclusion criteria related to slope, 

geological faults, hydrology, current land use, protected areas, population centers, road 

accessibility, and proximity to aerodromes. As a result, fifteen potential areas were 

initially identified for a sanitary landfill. A 10-year planning horizon (2026–2035) was 

estimated, projecting an increase in waste generation from 19.56 t/day in 2026 to 27.18 

t/day in 2035, requiring a minimum operational area of 9.48 ha for a semi-mechanized 

landfill. Field validation reduced the alternatives to two optimal areas totaling 66.38 ha; 

however, both are located 46–48 km from Pichari’s urban center, which limits their 

operational feasibility due to increased transportation and logistical costs. In conclusion, 

although technically suitable areas were identified, their distant location prevents 

considering these sites as feasible alternatives for implementing a sanitary landfill in the 

district. 

 

Keywords: Geographic Information Systems (GIS), multicriteria evaluation, optimal 

areas, sanitary landfill. 
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INTRODUCCIÓN  

La presente investigación “Identificación de Áreas Optimas para la Instalación de Relleno 

Sanitario, mediante SIG, en el Distrito de Pichari- provincia La Convención, Cusco”, 

proporciona información para la toma de decisiones en la gestión del ordenamiento 

territorial para la disposición final de los residuos sólidos. En los últimos años la 

generación de los residuos sólidos esta aun ritmo alarmante a nivel internacional que atañe 

a todo habitante del planeta, ya que el 90% de los desechos se vierten o queman a cielo 

abierto y  los pobres son los más vulnerables quienes son  los más afectados, se estima 

que por la rápida urbanización, el crecimiento de la población y el desarrollo económico 

harán que la cantidad de desechos a nivel mundial aumente a 70% y en los próximos 30 

años a un volumen asombroso de 3400 millones de toneladas de desechos generados 

anualmente. (Banco Mundial, 2018, 2024) 

Según el periódico Gestión (2024) en el plano ambiental “Gestión de residuos sólidos en 

el Perú: su avance y lo que plantea MINAM”, proporciona información, que en el Perú 

se generan 8,455,615 toneladas de residuos sólidos al año, lo que equivale a 23,166 

toneladas por día. De la cifra diaria, un 61.75% tiene como destino final los rellenos 

sanitarios y plantas de tratamiento, mientras que el resto termina en los llamados 

botaderos.  Según el último Inventario Nacional de Áreas Degradadas del Organismo de 

Evaluación y Fiscalización Ambiental (OEFA), existen 1,813 áreas degradadas por 

residuos sólidos conocidos como botaderos y en total de 77 rellenos sanitarios. 

El distrito de Pichari enfrenta una grave problemática relacionada con la gestión de 

residuos sólidos, ya que carece de un relleno sanitario adecuado. Este déficit se debe al 

incumplimiento de las normativas establecidas en la “Guía de identificación de zonas 

potenciales para infraestructura de disposición final de residuos sólidos municipales” del 

Ministerio del Ambiente (MINAM). En la actualidad, el distrito dispone de un botadero 

controlado en la comunidad de San Martín, que, aunque ha servido como punto de 

recepción de residuos sólidos municipales, se encuentra en la fase final de su vida útil. 

Este escenario es particularmente preocupante dado que el distrito ha experimentado un 

crecimiento poblacional significativo en los últimos años 

Los sistemas de información geográfica y la evaluación multicriterio permiten llevar a 

cabo estudios de mayor complejidad acorde a la realidad de los territorios. La aplicación 

de estos instrumentos y métodos facilitan la identificación de las problemáticas y por ende 

un acercamiento a las soluciones (Almonacid et al., 2023). Los SIG, pueden sintetizar 

https://gestion.pe/noticias/residuos-solidos/
https://gestion.pe/noticias/rellenos-sanitarios/
https://gestion.pe/noticias/rellenos-sanitarios/
https://gestion.pe/noticias/oefa/
https://gestion.pe/noticias/oefa/
https://gestion.pe/noticias/ministerio-del-ambiente/
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variables que determina la ubicación de los sitios óptimos  para relleno sanitario teniendo 

en cuenta los criterios establecidos en la norma los cuales son los siguientes : distancia a 

la población, distancia a aeropuertos, distancia a fuentes de agua superficiales , distancia 

a vías de acceso, uso actual del suelo, compatibilidad con la capacidad de uso mayor del 

suelo, propiedad del terreno, pendiente del terreno, barrera sanitaria natural, material de 

cobertura, distancia a instituciones educativas y centros de salud, drenaje del suelo 

,geología, pasivos ambientales, área natural protegida por el estado, área con restos 

arqueológicos, y vulnerabilidad por peligro geológico.(Ichpas  & Sanchez , 2021; Supo, 

2024). 
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I. PLANTEAMIENTO DEL PROBLEMA  

1.1. Descripción y formulación del problema. 

El aumento acelerado de la población a nivel mundial, ha generado que los 

residuos municipales aumenten, lo cual ha provocado que el manejo de los residuos 

sólidos se convierta en un problema (Ricaldi et al., 2021). En el documento “What a 

Waste 2.0: A Global Snapshot Of Solid Waste Management To 2050” publicado por  

(Kasa et al., 2018) en la revista de World Bank Group , que hasta  el 2016 se tenía 

registrado que a nivel mundial se generaba 2010 millones de toneladas y se predice  que 

en los próximos 30 años este aumente a 3400 millones de toneladas de residuos sólidos 

al año. 

El mal manejo de los residuos sólidos en las municipalidades, representa un 

peligro para la salud de las personas y al mismo tiempo trae consecuencias e impactos 

negativos al ambiente ocasionando el cambio climático, el riesgo es mayor si los residuos 

son dispuestos en zonas inoportunos como los botaderos informales (Kasa et al., 2018).  

En el Perú el 83 % de total de los residuos sólidos generados es destinado en zonas 

inadecuados, ocasionando daño al ambiente y salud de los seres humanos, el problema 

del manejo de residuos sólidos es la escasez de zonas óptimos que cumplan los criterios 

técnicos  para construcción de relleno sanitario (MINAM, 2016). 

El Distrito de Pichari no cuenta con un relleno sanitario debido al incumplimiento 

de las normativas establecidas en la “Guía de Identificación de Zonas Potenciales para 

Infraestructura de Disposición Final de Residuos Sólidos Municipales”, emitida por el 

Ministerio del Ambiente (MINAM). Actualmente, la gestión de residuos sólidos se 

realiza mediante su disposición en un botadero controlado, ubicado en el centro poblado 

de Otari de San Martín, el cual se encuentra en la fase final de su vida útil. 

El acelerado crecimiento poblacional del distrito ha generado que se intensifique 

la problemática de los residuos sólidos, evidenciada en la generación indiscriminada y el 

inadecuado manejo de estos. A ello se suma la limitada cultura ambiental de la población, 

así como el incremento en el consumo de productos de un solo uso, tales como plásticos, 

botellas PET, latas, cartón, vidrio y entre otros, lo que ha generado un aumento 

significativo en la cantidad de residuos dispuestos en el botadero controlado. Además, el 

sistema de recolección abarca tanto los centros poblados como las comunidades aledañas, 

lo que contribuye al incremento del volumen de residuos gestionados en la zona. 
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El inadecuado manejo de los residuos sólidos en el distrito de Pichari genera serias 

implicancias ambientales, sanitarias y sociales. Esta deficiencia impacta directamente en 

los componentes ambientales, provocando emisiones de gases, infiltración de lixiviados 

y la proliferación de vectores como moscas y roedores, además de la generación de olores 

ofensivos que deterioran la calidad de vida de la población del centro poblado de Otari 

San Martin., Pese a que la Municipalidad Distrital de Pichari percibe un importante monto 

del canon gasífero, recurso que debería garantizar la implementación de infraestructuras 

y sistemas de gestión ambientalmente adecuados.  

Como consecuencia, muchos pobladores recurren a la disposición inadecuada de 

sus residuos en puntos críticos como riberas de ríos, márgenes de carreteras y quebradas, 

lo que incrementa el riesgo de contaminación de cuerpos hídricos, degradación del 

paisaje, proliferación de enfermedades. Esta situación refleja no solo una problemática de 

salud pública y deterioro ambiental, sino también una falta de alineamiento entre la 

disponibilidad de recursos financieros municipales y la gestión técnica requerida para la 

instalación de un relleno sanitario. 

En este sentido, la parte medular de la situación problemática precisa la 

elaboración de un trabajo asertivo de identificar áreas óptimas que cumplan con los 

criterios y las normas establecidos para la implementación de relleno sanitario en el 

Distrito de Pichari. 

1.1.1. Formulación del problema General 

¿Cuáles son los sitios que cumplan las condiciones óptimas para la instalación de un 

relleno sanitario, mediante SIG, en el distrito de Pichari, provincia la convención - Cusco? 

1.1.2. Formulación de Problemas Específicos 

PE1. ¿Cuáles son los criterios de selección que nos permita elaborar mapas 

temáticos para fijar zonas apropiadas para la instalación del relleno 

sanitario? 

PE2. ¿Qué datos de ponderación se le otorgará según la técnica de 

evaluación multicriterio? 

PE3. ¿Cuál es el tipo de relleno sanitario a instalar en el distrito de Pichari? 

PE4.  ¿Cuáles son los sitios óptimos para la instalación de un relleno 

sanitario mediante el SIG? 
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1.2. Objetivos  

1.2.1. Objetivo General  

Identificar áreas óptimas para la instalación de relleno sanitario utilizando el Sistema de 

Información Geográfica (SIG), en el distrito de Pichari - Provincia La Convención- 

Cusco.  

1.2.2. Objetivos específicos  

OE1   Utilizar los criterios de selección que nos permita elaborar mapas temáticos 

para fijar áreas óptimas para la instalación de un relleno.  

OE2   Generar base de datos y ponderación basadas en técnica de evaluación 

multicriterio. 

OE3    Identificar los tipos de relleno sanitario a instalar. 

OE4    Localizar sitios óptimos para la instalación de rellenos sanitarios mediante el 

SIG.  

1.3. Justificación e importancia  

1.3.1.  justificación teórica 

El presente trabajo permite evaluar y descubrir sitios para la localización de áreas óptimas 

para la instalación de  rellenos sanitario, el sistema de información geográfica (SIG) y 

técnicas de evaluación, que nos permite descubrir localizaciones superiores para 

identificar los diversos usos del suelo que queremos hacer en una zona (Ichpas y Sanchez, 

2021).  

 El enfoque de este estudio es la revisión de diferentes investigaciones nacionales e 

internacionales que permite entender que existen tres posiciones fundamentales: la 

sostenibilidad ecológica, económica y social, lo que se conoce como asegurar el equilibrio 

del ecosistema. Asimismo, este estudio sirve como referencia para otros estudios y como 

complemento para estudios de proyecto de inversión, de esta manera esta investigación 

se basa en criterios y teorías que brindarán nuevos productos que teóricamente serán una 

guía para la ubicación de sitios óptimos para la instalación de relleno sanitario en el 

distrito Pichari, provincia La Convención-Cusco. 
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1.3.2. Justificación práctica 

El desarrollo de un modelo espacial para la identificación de áreas optimas de relleno 

sanitario para la disposición final de residuos sólidos, puede ser utilizado como una 

herramienta de apoyo verificable y complementaria para futuras investigaciones (Loyaga, 

2019). 

Esta investigación nos permite a través del sistema de información geográfica (SIG), la 

identificación de sitios óptimos para la construcción de relleno sanitario en el Distrito 

Pichari. esto implica que el sistema de información geográfica (SIG-ArcGIS), se 

convierten en una herramienta fundamental que puede ser utilizado en diversos trabajos 

y mejorar los procesos de identificación y  selección, mejorando la toma de decisiones 

según los criterios de selección en la "Guía para el diseño y construcción 

de infraestructura para la disposición final de residuos sólidos municipales”; así afrontar 

la problemática y poder dar la respuesta adecuada y  la mejor ubicación adecuada del sitio  

para la instalación de un relleno sanitario. 

1.3.3.  Justificación social. 

Uno de los motivos que sobrelleva a esta investigación es que el distrito de Pichari solo 

cuenta con un área para la disposición final de los residuos sólidos de carácter municipal, 

que en un futuro muy próximo no abastecerá por el aumento poblacional y generando otra 

dificultad en el manejo de residuos sólidos. 

Esta investigación ayudara a identificar sitios adecuados para la disposición final de los 

residuos de manera óptima basado en los sistemas de información geográfica (SIG), que 

al utilizar brindaría una solución a la población, asimismo, de esta manera se busca una 

alternativa que permita establecer un nuevo ordenamiento territorial. Con este trabajo se 

reduciría la contaminación de los componentes ambientales (seres vivos, suelo, agua y 

aire), siempre que signifique también promover una cultura ambiental en la que los 

habitantes de la zona comprendan el daño que se hace al medio ambiente por los residuos 

sólidos en sitios inadecuados que no cumplen los criterios establecidos en la guía. 

Asimismo, este estudio es necesario porque es de beneficio directo para la municipalidad 

de Pichari para la formulación de proyectos de inversión de relleno sanitario. 
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1.4. Hipótesis 

• Hipótesis nula (H0). No existirá alguna área potencial que reúna las condiciones 

adecuadas para la instalación de relleno sanitario 

• Hipótesis alternativa (H1). Existirán sitios potenciales que reúnan las 

condiciones adecuadas para la instalación de un relleno sanitario. 

1.5. Identificación de variables  

1.5.1 Variable 1 

 Sistema de información geográfica.  

1.5.2 Variable 2  

Identificación de áreas óptimas para la instalación de relleno sanitario. 
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Tabla 1 

Operalización de variables  

 

Variable 

dependiente 

Variable 

independiente 

Definición 

conceptual 

Definición 

operacional 

Dimensiones Indicadores Criterios Instrumentos 

(Geoprocesamiento 

ArcGIS 10.8) 
 Campos Aspectos 

Identificación 

de áreas 

óptimas para 

la instalación 

de relleno 

sanitario 

Sistema de 

información 

geográfica 

La identificación 

de áreas óptimas 

se define como 

un procedimiento 

de evaluación 

espacial basado 

en la integración 

multicriterio de 

variables físicas, 

ambientales y 

socioeconómicas, 

cuyo propósito es 

determinar zonas 

del territorio que 

presentan las 

condiciones 

adecuadas y 

suficientes para la 

instalación de una 

infraestructura, 

conforme a 

criterios de 

aptitud, 

restricción y 

normativa técnica 

vigente. 

Para la 

identificación de 

sitios óptimos se 

utilizó como 

herramienta de 

recolección de 

datos geo portales 

públicos y local 

(ZEE-Pichari), 

que contienen 

capas de 

información 

cartográficas de 

medios  (físicos, 

biológicos y 

socioeconómicos), 

y a través de la 

técnica de 

evaluación 

multicriterio 

(ponderación) y el 

análisis espacial  a 

través del software 

ArcMap del 

ArcGIS Desktop, 

se realizó las 

mapas temáticos 

de acuerdo a lo  

establecidos en la 

guía para el 

Diseño y 

construcción de 

infraestructuras 

para disposición 

final de residuos 

Municipales   

Aspectos     del    

medio físico 

Ámbito 

territorial 

Ubicación 

geográfica 

Ausencia de 

infraestructura 

de rellenos 

sanitarios 

INEI (limites) 

 
 

Rango de pendiente < 25 % Shapefile de ZEE- 

Pchari e IGN  
 

 
Distancia a las 

fallas geológicas 

< 1000 metros IGN – ZEE Pichari 

 
 Aspectos medio 

biológicos  

 
Distancia a fuente 

de agua 

< 500 metros ANA -  ZEE- 

 
 

 
Presencia de A.N.P. Ponderación 

binaria (0,1)  

SERNAMP -  ZEE 

Pichari 

 
 Aspectos medio 

socioeconómicos  

 
Distancia a las vías 

de acceso 

Distancia a vía 

de acceso 

principal km 

ZEE Pichari 

 
 

 
Presencia de sitios 

arqueológicos 

Ponderación 

binaria (0,1)  

MINCUL 

 
 

 
Distancia a las 

áreas urbanas  

≥ 500 m ZEE Pichari - INEI 

 
 

 
Distancia a 

aeropuertos  

≥ 13km ZEE Pichari 

 
 

 
Uso actual de suelo 

(agrícola) 

≥ 500 m Shapefile de ZEE- 

Pchari 
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II. MARCO TEÓRICO  

2.1. Antecedentes  

2.1.1. Antecedentes internacionales 

Flores (2013) en su tesis titulada “Identificación de sitios potenciales para la 

disposición final de residuos sólidos en los municipios Atlacomulco, Ixtlahuaca y 

Jocotitlán, estado de México” concluye que: Para la ubicación de sitios potenciales  la 

mayoría utilizan los criterios de selección  para determinar la distancia a ciertos factores 

y los límites de las normas oficiales mexicanas (083.SEMARNAT-

2003), ubicado a varios metros de distancia, lo que crea incertidumbre, evaluándolo 

como un lugar que podría ser adecuado para la selección del sitio candidato, los 

resultados obtenidos por SIG se aproximan a la situación real en algunos lugares, y 

utilizando otros criterios y en base a variables específicas ponderadas en un mejor 

manera. 

Según Erazo (2016) realizó un relevamiento con el objetivo de identificar sitios 

adecuados para la implementación de rellenos sanitarios en el municipio de Pupiales-

Nariño, utilizando el software ArcGIS versión 10.2 para la obtención de capas espaciales 

(polígonos) que ayuden en el marco de la ordenación territorial, luego de aplicar la 

metodología se logró identificar  áreas potencialmente aptas para la implementación de 

un relleno sanitario. 

Hailu et al., (2019) menciona que el área de disposición de residuos sólidos es un 

asunto de preocupación de salud pública, se tiene que hacer la selección de un sitio 

apropiado minimizando el impacto ambiental, para ubicar un sitio de relleno sanitario 

adecuado para el caso de la ciudad de Wolkite se debió tener en cuenta múltiples aspectos, 

tales como como uso del suelo, cobertura del suelo, se utilizaron como factores el suelo 

y la pendiente. Además, la proximidad de aguas superficiales como: ríos, arroyos, pozos 

de suministro de aguas subterráneas, carreteras, instalaciones públicas como: escuelas, 

centros de salud, oficinas administrativas, iglesias, mezquitas, otras áreas construidas y 

sitios culturales se consideraron como rellenos sanitarios. Restricciones, el análisis de 

datos se llevó a cabo a través del software GIS, finalmente se identificó el sitio de relleno 

sanitario candidato.  

Por otro lado, Kareem et al. (2021),  evaluó el sitio de relleno sanitario óptimo 

para la ciudad de An-Najaf utilizando el método GIS y criterios, para ello se seleccionaron 

ocho criterios apropiados, que son: área urbana, ríos, caminos, tipos de suelo, elevación, 
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viento, pendiente y sitios arqueológicos, históricos y religiosos. Además, la ponderación 

de los criterios utilizando la opinión de expertos y literatura similar previa. 

Según Ali et al., (2023)  menciona que para la selección adecuada del sitio de 

relleno sanitario requiere la consideración de varios criterios ambientales, sociales y 

económicos en un sofisticado análisis de decisiones de criterios múltiples dentro del 

sistema de información geográfica (SIG) y tuvo  como objetivo proporcionar una base 

científica para la identificación de vertederos.    

En Grecia, los investigadores Parastatidou et al., (2024),  utilizaron  la lógica 

booleana y el sistema de información geográfica para excluir áreas no adecuadas para el 

establecimiento de un relleno sanitario y para seleccionar áreas con la mayor idoneidad 

para la disposición final de los residuos sólidos,  las áreas adecuadas se les dio un valor 

de uno (1), mientras que a las áreas no adecuadas se les dio un valor de cero (0), 

obteniendo como resultado según las mapas temáticas un 12.7%  del área de estudio es 

adecuado para la instalación de los rellenos sanitarios 

En ecuador, los investigadores Bello et al., (2025) utilizaron los  herramientas de 

análisis espacial y evaluación multicriterio para identificar áreas óptimas para la 

instalación de un relleno sanitario en el cantón Chone, la metodología empleada incluyó 

el cálculo de la dimensión requerida del relleno sanitario proyectado al año 2040, en base 

a una población estimada de 130,696 habitantes y una generación per cápita de residuos 

sólidos de 0.58 kg/hab/día, lo que determinó una necesidad de 12.34 hectáreas de 

superficie. Se definieron y evaluaron nueve criterios ambientales mediante el Proceso de 

Jerarquía Analítica (AHP), lo que permitió establecer una matriz de ponderaciones única. 

Los criterios con mayor influencia fueron la distancia a áreas protegidas (29%) y la 

pendiente del terreno (21%). Con estos valores, se ejecutó un modelo de evaluación 

multicriterio en un entorno SIG, que permitió identificar 20 áreas óptimas que en conjunto 

abarcan 18,196.04 hectáreas, equivalentes al 5.36% del territorio del cantón. 

2.1.2 Antecedentes nacionales  

El tratamiento integral de los residuos sólidos comprende diferentes etapas desde 

el origen, clasificación y disposición adecuada, a esto se agrega las múltiples brechas que 

condicionan la gestión integral de los residuos sólido. Por lo tanto, es importante estudiar 

y brindar información sistemática que ayude a seleccionar las superficies óptimas  para 

su disposición final con el fin de reducir los conflictos sociales y ambientales. ( MINAM, 

2017; Ichpas y Sanchez , 2021)  
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Javier  (2015) desarrollo un modelo para la identificación y localización de un 

área óptima para la instalación de un relleno sanitario, realizando análisis mediante 

técnicas multicriterio en un SIG, abarcando los doce distritos de la provincia de Huánuco, 

implemento criterios para la selección de áreas que inciden en la disposición final de 

residuos sólidos en rellenos sanitarios, localizando áreas factibles para la instalación de 

residuos sólidos. 

Romero (2017) en su tesis titulada “identificación de las áreas óptimas para la 

planta de tratamiento y disposición final de residuos sólidos del distrito de san Ignacio, 

utilizando sistemas de información geográfica – SIG” concluye que para identificar áreas 

potenciales para la instalación de una planta de tratamiento y disposición final se utilizó 

el sistema de información geográfica (SIG). Para ello se establecieron  nueve criterios 

técnicos de evaluación  (distancia a carreteras, distancia a zonas urbanas, fallas 

geológicas, geología, hidrología, infraestructura existente, pendiente, uso de suelo 

forestal y zonas arqueológicas), empleando la evaluación multicriterio que consistió en 

superponer cada  criterios respectivo y dando valor de “0” (áreas no óptimas de color 

rojo) y “1” (áreas óptimas de color azul); obteniendo como resultado un mapa que cumple 

con todo los criterios  y siendo superior a 5 ha,  por lo que en total existen 17 áreas donde 

se pueden construir plantas de tratamiento y disposición final de residuos sólidos. 

Espejo (2018) utilizó el SIG para localizar un área adecuado para la construcción 

de un relleno sanitario en el distrito de Chachapoyas, departamento de  Amazonas, Perú,, 

aplicando los siete criterios de selección teniendo los variables de pendiente, geología, 

distancia a carreteras, bosques, distancia a la población (urbana y rural), distancia al 

aeropuerto y el volumen de almacenamiento, estos criterios fueron evaluados mediante la 

evaluación multicriterio, los resultados obtenidos en este estudio, demuestra que 

utilizando los sistemas de información geográfica (SIG) y sus diversas herramientas, 

determinaron ubicar las áreas óptimas para la ubicación del relleno sanitario para el 

distrito de Chachapoyas y que tenga menor impacto sobre el ambiente.  

Perez (2019) realizó un asertivo proyecto de investigación que implicó identificar 

las áreas más adecuadas para la instalación de un relleno sanitario en Santa Rosa, Jaén, 

departamento de Cajamarca. La evaluación utilizó 'un sistema de información geográfica' 

como apoyo para la toma de decisiones, teniendo en cuenta la guía de diseño, 

construcción, operación, mantenimiento y cierre de rellenos sanitarios manuales' 

publicada en el MINAM, que identificó siete sitios adecuados para la instalación de 
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rellenos sanitarios con base en criterios y variables. 

En un trabajo de investigación Loyaga (2019)  identifico 2 áreas optimas y 13 

áreas aceptables para la instalación de un relleno sanitario utilizando  herramientas de 

sistema de información geográfica (SIG),  en el distrito de Las Parias - provincia de Jaén, 

utilizo los criterios establecidos en la “Guía de Diseño, Construcción, Operación, 

Mantenimiento y Cierre del Relleno Sanitario Manual del MINAM”, empleando la 

evaluación multicriterio, “0” para áreas que no son consideradas para la instalación del 

relleno sanitario, “1” para áreas potenciales para la instalación de un relleno sanitario y 

“2” para áreas admisibles que de igual manera si cumplen con las condiciones para la 

construcción del relleno sanitario. 

Mamani (2020) realizo un estudio orientado a “identificar de áreas óptimas para 

la disposición final de residuos sólidos en el distrito y provincia de Sandia, departamento 

de Puno”, a una altitud de 2180 msnm; el estudio se llevó a cabo con tres alternativas 

Challapata, Alicato y que neque, y se realizó la superposición de capas en el ArcGIS 10.3, 

mediante el análisis espacial. se concluyó que la alternativa 2 (Alicato) es la mejor 

alternativa para un relleno sanitario: tiene buen acceso vial, buena distancia a fuentes de 

agua superficial, dirección opuesta del viento, presencia de material de cobertura, 

topografía (32-44%), la precipitación es de (1000 – 1050 mm de precipitación media 

anual), y mejor estabilidad física del suelo, lo cual es favorable porque presenta un drenaje 

favorable sin riesgo de inundaciones y erosión hídrica. 

Por otro lado,  Ito (2020) realizo una investigación para  identificar sitios aptos  

para la instalación de relleno sanitario en la Municipalidad Distrital de Coata del 

departamento de Puno, que actualmente no cuenta con un relleno sanitario pero si con un 

botadero, a causa de ello genera problemas ambientales., Se empleó el software ArcGIS 

10.5, con el análisis multicriterio fijando valores de 0 y 1, para áreas no aptas y aptas, 

utilizando las variables de pendiente, distancias a centro poblado y ríos., por lo que se 

identificaron tres áreas potenciales para la instalación de un relleno sanitario con un 

superficie de  39.76, 93.09, y 491.71 hectáreas.  

En el distrito de Huayrapata, provincia de Moho, Puno, se identificó sitios 

potenciales para la construcción de un relleno sanitario mediante el sistema de 

información geográfica, software ArcGIS 10.5, utilizando los siguientes criterios: 

pendiente, fallas geológicas, hidrología y vías de acceso establecidos en la guía de diseño, 
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construcción, operación, mantenimiento y cierre de relleno sanitarios.  Como resultado 

se identificaron cuatro áreas potenciales con superficies 766,247, 154 y 161 ha, para la 

ubicación de relleno sanitario, utilizando la aplicación del sistema de información 

geográfica mediante la evaluación multicriterio. (Mamani, 2020) 

Rodríguez (2020) diseñó un modelo geoespacial para la ubicación óptima de 

instalaciones para la disposición final de residuos sólidos, mediante la  aplicación de SIG 

en la provincia de Jaén – Cajamarca, dentro de sus conclusiones se detalla  que 2% del 

área total son consideradas potenciales para el establecimiento de rellenos sanitarios en 

la provincia de Jaén, todo esto mediante el uso de mapas en Sistema de Información 

Geográfica (SIG), donde se realizó el proceso de interpretación del espacio mediante 

ponderaciones binarias de varias variables analizadas, donde “1” son  áreas descartados 

para la instalación de relleno sanitario “0” son áreas potencialmente aptas  para la 

ubicación de la propuesta, también  se realizó la evaluación multicriterio de varias 

variables teniendo en cuenta los criterios físico, biológico y sociales , para lo cual  se tuvo 

en consideración la “ Guía de diseño construcción, operación, mantenimiento y cierre del 

relleno sanitario manual y el D.S. 014-2017 –MINAM. 

Ichpas y Sánchez  (2021) localizó siete sitios  para la instalación  de  rellenos 

sanitarios en la ciudad de Huancavelica utilizando el sistema de información geográfico, 

donde se evaluaron 19 parámetros que permiten la ponderación final de sitios para 

rellenos sanitarios tales como la “distancia a la población, distancia a cobertizos, distancia 

a aeropuertos, distancia a fuentes de agua superficiales , distancia con respecto a la ciudad, 

distancia a vías de acceso, uso actual del suelo, compatibilidad con la capacidad de uso 

mayor del suelo, propiedad del terreno, pendiente del terreno, cuenta con barrera sanitaria 

natural, material de cobertura, distancia a instituciones educativas y centros de salud, 

drenaje del suelo ,geología, pasivos ambientales, área natural protegida por el estado, área 

con restos arqueológicos, y vulnerabilidad por peligro geológico”.  

Becerra (2021)  identificó área apta para la instalación de un relleno sanitario en 

el distrito de Catilluc, provincia de San Miguel, Cajamarca, utilizando el sistema de 

información geográfica, teniendo como resultado un área apta de aproximada de 182.24 

ha, que cumple con todos los parámetros establecidos en la guía de diseño y construcción 

de un Relleno Sanitario del MINAM.  

En el departamento de Puno- provincia Collao, el investigador  Supo (2024), 
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justifica su investigación  de identificar áreas potenciales para la instalación mencionando 

la problemática de contaminación ambiental de los componentes (agua, aire, y suelo), 

incluida la salud pública al no contar con relleno sanitario  en la provincia, para ello utilizo 

la metodología de geolocalización utilizando la Evaluación Multicriterio y el software 

ArcGIS, como resultado logró identificar 187844.66 ha de superficie que cumplen con 

los criterios establecidos en la guía. 

2.1.3. Antecedentes locales 

En el entorno local  encontramos que en la provincia de Cusco, Uscamayta (2021), 

tuvo como objetivo determinar áreas aptas para la instalación de rellenos sanitarios, donde 

utilizó la técnica de evaluación Multicriterio y el sistema de información Geográfica 

(SIG) software ArcMap versión 10.2,  la investigación procedió mediante dos etapas pre 

- campo que consistió realizar el análisis espacial con la herramienta de ArcGIS, en la 

etapa de campo ya se define las zonas aptas, como resultado arrojo 4 áreas con potencial 

media para la instalación de relleno sanitario. 

En el distrito de  Santa Ana- Cusco, la investigadora Paz (2023),  describe que las 

zonas óptimas para relleno sanitaria son muy escasas debido al cumplimiento de los 

parámetros establecidos en la guía y normativas vigentes, para ello planteo como objetivo 

determinar zonas óptimos para relleno sanitario, cuyos instrumentos de recolección de 

datos fueron los portales de organismos públicos nacionales e internacionales, realizando 

el procesamiento en el software Arcmap10.3. como resultado final se obtuvo 79 ha de 

zona potencial para la instalación de rellenos sanitarios. 

2.2. Bases teóricas  

2.2.1. Rellenos sanitarios  

El relleno sanitario es una técnica de disposición final de residuos sólidos en el 

suelo, mediante el uso de principios de ingeniería para confinar la basura en un área 

previamente implementada con los dispositivos para el control y manejo de las emisiones 

(líquidos y gases), con la finalidad de prevenir los riesgos a la salud pública y deterioro 

de la calidad ambiental (MINAM, 2020). 

2.2.2. clasificación de rellenos sanitarios  

2.2.2.1. Relleno Sanitario Manual. El relleno sanitario manual es una tecnología que se 

aplica cuando la mano de obra está más disponible que la maquinaria que haría el mismo 
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trabajo. Asimismo, está diseñado para dar disposición final a los residuos sólidos de 

poblaciones que producen hasta seis (6) toneladas diarias (t/día) de residuos sólidos. sólo 

se requiere equipo pesado para la adecuación del sitio y la construcción de vías internas 

y excavación de zanjas o material de cobertura. En cuanto a los demás trabajos, todos 

pueden realizarse manualmente, como el esparcido, compactación y cobertura de los 

residuos se realiza mediante el uso de herramientas simples como rastrillos, pisones 

manuales, entre otros (MINAM, 2020; Delgado y Zavaleta, 2021). 

Figura 1 

Relleno sanitario manual 

 

Fuente: MINAM, (2020). Guía para el diseño y construcción de infraestructuras para 

disposición final de residuos municipales.  

2.2.2.2 Relleno Sanitario Semi-mecanizado. Incorpora todos los elementos 

fundamentales de un relleno sanitario, construido y administrado con principios de 

ingeniería civil y sanitaria para áreas urbanas, que se aplica para dar disposición final de 

los residuos sólidos de poblaciones que producen de seis (6) t/día hasta los cincuenta  (50) 

t/día., la característica principal de este tipo de relleno, es que las operaciones diarias se 

requiere de equipo pesado para  los trabajos de esparcido, compactación y cobertura de 

los residuos se realizan con el apoyo de equipo mecánico, siendo posible también el 

empleo de herramientas manuales para complementar los trabajos de confinamiento de 

residuos (MINAM, 2020; Delgado y Zavaleta, 2021). 
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Figura 2 

Relleno sanitario semi-mecanizado 

 

Fuente: MINAM, (2020). Guía para el diseño y construcción de infraestructuras para 

disposición final de residuos municipales.  

2.2.2.3 Relleno Sanitario mecanizado. Las operaciones en el relleno sanitario se realizan 

íntegramente a través de equipo pesado, ya sea en forma parcial o permanente, la 

utilización de estos equipos se realiza cuando la producción diaria de residuos sólidos es 

de 50 o más toneladas (MINAM, 2020). 

Figura 3 

Relleno sanitario mecanizado 

 

Fuente: MINAM, (2020). Guía para el diseño y construcción de infraestructuras para 

disposición final de residuos municipales.  
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2.2.3. Métodos de Rellenos Sanitarios 

❖  El método de área. Es adecuado para áreas planas o con pendientes suaves donde 

pueden existir algunas depresiones de tierra, los residuos se esparcen, compactan 

y luego se cubren con material de cobertura que pueden ser transportados desde 

zonas aledañas a la zona (Ricaldi et al., 2021). 

❖ El método de zanja. Los residuos sólidos se esparcen, compactan y cubren 

cavando una zanja, este método es efectivo para  zonas casi nivelados donde el 

nivel freático no está cerca de la superficie, normalmente, el suelo excavado de la 

zanja se utiliza como material de cobertura (Ricaldi et al., 2021). 

❖ El método de pendiente o rampa. Se utiliza a veces en combinación con los dos 

métodos anteriormente mencionadas, los residuos se esparcen sobre un talud 

existente, se compactan y se cubren y los materiales de cobertura generalmente 

vienen de delante de la cara de trabajo (Ricaldi et al., 2021). 

2.2.4. superficie de terreno y vida útil 

Según la Guía de Instalación y Construcción de Rellenos Sanitarios de Residuos 

Municipales del (MINAM, 2020), considera que la planificación de la infraestructura 

destinada a la disposición final de residuos sólidos debe considerar una vida útil mínima 

de diez (10) años. La proyección del área del terreno se calcula en función de la cantidad 

diaria de residuos sólidos generados, aplicando criterios específicos para rellenos 

sanitarios de tipo (manual, semi-mecanizado y mecanizado). 

Tabla 2 

Superficies de terrenos para rellenos sanitarios 
 

R. S. manual  
(6tn/día) 

R. S. semi- 
mecanizado 
(50tn/día) 

R. S. mecanizado 
(100tn/día) 
(800tn/día) 

Celda transitoria, vida útil 
3 (tres) años. 

0,25 ha 1,45 ha 3,00 a 15,00 ha 

Relleno sanitario vida útil 
10 (diez) años. 

0,75 ha 3,30 ha 10,00 a 25,00 ha 

Vías, campamento, áreas 
libres, infraestructuras 
diversas. 

4,00 ha 5,25 ha 10,00 ha 

superficie min. 
Recomendable. 

5,00 ha 10, 00 ha 23,00 a 50,00 ha 

    

 Fuente: MINAM, (2020). Guía para el diseño y construcción de infraestructuras para 
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disposición final de residuos municipales.  

2.2.5 Guía para la identificación de zonas potenciales para infraestructura de 

disposición final de residuos sólidos municipales. 

El objetivo de la guía es orientar en la identificación de áreas que tienen potencial 

para implementación de infraestructuras para la disposición final de residuos sólidos 

municipales, acordes a las potencialidades y limitaciones del territorio. Asimismo, 

muestra los pasos, fases y criterios técnicos y normativos para la identificación de las 

infraestructuras de disposición final de residuos sólidos municipales (MINAM, 2020). 

2.2.5.1 contenidos mínimos para la selección de áreas. 

a) Relación del área propuesta con infraestructura existente 

No se podrán seleccionar áreas que se encuentren dentro de las áreas de 

influencia de obras de infraestructura tales como embalses, represas, refinerías, 

obras hidroeléctricas, entre otros; la distancia de la infraestructura para 

disposición final de residuos incluyendo una celda transitoria no será menor de 13 

000 m. (MINAM, 2020). 

b)  Extensión del terreno y vida útil 

La adecuada selección del terreno hará posible la construcción de una 

celda transitoria y la posterior dotación de infraestructura para disposición final 

de residuos con la mayor vida útil posible, los periodos de vida útil a considerar 

son: Infraestructura para disposición final de residuos sólido, vida útil no menor 

a diez (10) años; celda transitoria, vida útil máxima de tres (03) años y por último 

Nave para pretratamiento y relleno seco, vida útil recomendable no menor a 

quince (15) años. (MINAM, 2020) 

c) Factores climáticos, suelo y relieve de la superficie, aspectos geológicos, 

geomorfológico, hidrogeológia, entre otros. 

- Climáticos: El factor importante es la dirección del viento predominante ya 

que el polvo, el tráfico deficiente y los malos olores pueden causar fatiga en 

la operación. Además, es importante estar atento a las siguientes condiciones 

climáticas: precipitación, temperatura y humedad relativa, que facilitarán la 

biodegradación de los residuos. (MINAM, 2021) 

- Relieve de la superficie: Uno de los factores importantes es tener terrenos 
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llanos a ondulados (Hasta 30° de inclinación son aptas para la adecuación  de  

infraestructura para disposición final de residuos), terrenos accidentados y 

elevaciones rocosas son inadecuadas” (MINAM, 2020, 2021). 

- La geología y geotecnia: Es importante conocer el tipo y las características 

mecánicas del suelo para la instalación de un relleno sanitario. En este caso se 

podría recomendar las características areno arcilloso debido a que son suelos 

poco permeables, y eso nos permite que la infiltración de líquido contaminante 

se reduce considerablemente (MINAM, 2020). 

- Geomorfología: Las condiciones climáticas o antrópicas, podrían generar 

riesgos de erosión y deslizamientos en el terreno, causados por la gravedad y 

otros factores naturales como litológicos, climáticos antrópicos, entre otros” 

(MINAM, 2020, 2021).  

- Hidrogeología: Para la selección del sitio y uno de los factores importantes 

es evitar la contaminación de los acuíferos. Para lo cual es recomendable 

realizar estudios de geohidrológicos para identificar la posibilidad de 

existencia de acuíferos sub superficiales, la profundidad a la que se 

encuentran, la dirección y la velocidad del escurrimiento o flujo (MINAM, 

2020). 

- Hidrología superficial: En este caso es recomendable que el área 

seleccionada este ubicada a una distancia considerable de las corrientes 

superficiales de los cuerpos de agua; la mayor parte de los problemas 

ocasionados es por el escurrimiento de aguas; partiendo de ese problema es 

muy importante que el sitio seleccionado esté a una distancia considerable 

para evitar escurrimientos dentro del relleno sanitario (MINAM, 2020). 

d) Material para cobertura 

El lugar seleccionado debe contener material de cobertura (tierra), y con cantidad 

suficiente de tierra que pueda ser extraída sin dificultad y a costos razonables, para 

cubrir la demanda necesaria para la conformación de diques, cobertura y sellado 

de la celda transitoria, relleno sanitario y relleno seco, a lo largo de la vida útil de 

la infraestructura., los estratos areno limosos y areno arcillosos son los adecuados. 

(MINAM, 2020, 2021) 
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e) Barrera sanitaria y aislamiento paisajístico 

El lugar destinado a una celda transitoria y/o infraestructura para 

disposición final de residuos sólidos este con cerco perimetral, se complementará 

con un cerco vivo interior y paralelo, de preferencia con especies nativas de la 

zona, complementados con la dirección de los vientos, evitarán que las partículas 

y polvo que inevitablemente se genera en la actividad, lleguen a la población más 

cercana. (MINAM, 2020) 

f) Vías de acceso 

Las vías de acceso son de mucha importancia para la instalación de un 

relleno sanitario, por lo tanto, el sitio debe estar de preferencia a corta distancia 

del área urbana para no afectar el costo global del sistema, retardando los viajes y 

daños vehiculares; Se priorizarán conexiones existentes y que la distancia 

referencial máxima de aprox. De treinta (30) km desde el centro de la ciudad 

(rellenos sanitarios mecanizados y semimecanizados) y distancia referencial 

máxima de aproximadamente 10 kilómetros desde el centro de la ciudad para 

rellenos sanitarios manual. (MINAM, 2021) 

g) El uso de suelo y planes de expansión urbana 

El lugar destinado a un proyecto de celda transitoria, relleno sanitario y 

relleno seco, se debe tener en cuenta la proyección de expansión poblacional 

planificada por la municipalidad involucrada, para tal sentido se debe realizar un  

estudio de suelo, que este detallado mayormente en el plan de desarrollo urbano 

distrital (MINAM, 2020). 

h) Opinión pública 

Es importante que el lugar seleccionado tenga la aprobación de la 

población beneficiaria, así como de la población colindante al terreno, para evitar 

posibles conflictos sociales a (corto y largo plazo), tipificado en la Ley N.º 29785, 

ley de derecho a la consulta previa. (MINAM, 2020, 2021) 

i) Áreas naturales protegidas por el estado 

El área  para la instalación de relleno sanitario  no debe estar ubicado en 

un área natural protegida por el estado, por ello, se deberá contar con el certificado 

de no afectación de áreas naturales protegidas emitido por el SERNANP 
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(MINAM, 2020). 

j) Preservación del patrimonio cultural 

El área no debe estar ubicado en zona arqueológica, arquitectónica, histórica o 

patrimonial, de ser así, es un criterio de restricción de ubicación; el sitio 

proyectado para la infraestructura de disposición final debe contar con el 

certificado de inexistencia de restos arqueológicos (CIRA) (MINAM, 2020). 

2.2.5.2 Aspectos legales  

a. Saneamiento físico legal del terreno  

El área utilizada para el relleno sanitario debe estar debidamente saneado 

y tener título de propiedad, así como documentos legales que le autoricen a 

construir un relleno sanitario y todas sus obras anexas en el terreno, y un 

representante registrado en el Servicio Nacional de Registros Públicos (SUNARP) 

a nombre de gobiernos locales que implementará la infraestructura de disposición 

final para rellenos sanitarios. (MINAM, 2020, 2021) 

b. Reglas legales del Perú para la implementación de infraestructura de 

residuos solidos  

- Ley General del Ambiente - Ley Nº 28611 

La tarea especial del Ministerio del Ambiente (MINAM), es promover y 

coordinar el manejo adecuado de los residuos sólidos, la calidad del aire y el 

control del ruido y las radiaciones no ionizantes como indica  de  en su art. 7, literal 

k) y, sanciones por su incumplimiento, en su art. 67, sugiere sobre saneamiento 

básico que también señalan que las autoridades públicas de a nivel nacional, 

sectorial, regional y local dan prioridad a las medidas de saneamiento básico, 

incluyendo la construcción y gestión de infraestructura de residuos sólidos en las 

zonas urbanas y rurales. 

- Ley Marco del Sistema Nacional de Gestión Ambiental, Ley N° 28245. 

Según el art. 6, el MINAM proporciona herramientas de gestión y 

planificación ambiental, las cuales son responsables de asegurar la coordinación 

intersectorial y el uso adecuado de estas herramientas a través del desarrollo de 

políticas, estándares o metodologías. Según el artículo 9, inciso d, la función del 

MINAM es desarrollar políticas ambientales y normas de regulación. 
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- Ley de Gestión Integral de Residuos Sólidos, aprobada por Decreto 

Legislativo N.° 1278. 

En el art. N° 6 de los Lineamientos para la Gestión Integral de Residuos 

Sólidos, coordinan la secuencia territorial y la política de manejo de residuos 

sólidos para asegurar una gestión efectiva de la infraestructura de residuos sólidos. 

También identifican áreas apropiadas para la disposición final de los residuos 

sólidos, teniendo en cuenta las necesidades actuales y futuras, y establecen planes, 

programas, estrategias, medidas transversales, teniendo en cuenta el seguimiento 

económico, social, cultural, tecnológico, sanitario y prácticas sostenibles. 

- Reglamento de Zonificación Ecológica y Económica (ZEE), aprobado 

mediante Decreto Supremo N.° 087-2004-PCM. 

La ZEE es un enfoque adaptativo y dinámico que considera el potencial de 

uso sostenible de regiones específicas, basándose en la consideración de factores 

físicos, biológicos, sociales, económicos y culturales. Entre sus objetivos se 

destacan: lineamientos para la elaboración, aprobación y aplicación de 

políticas para el aprovechamiento sustentable de los recursos naturales 

y territorios a nivel nacional, sectorial, regional y local y para la gestión 

ambiental de acuerdo con sus características y potencialidades. Ecosistemas, 

protección ambiental y bienestar humano; proporcionar información técnica 

y sistemas de referencia para facilitar la inversión tanto pública y privada 

- Reglamento de Organización y Funciones del MINAM, aprobado por Decreto 

Supremo N.° 002-2017-MINAM. 

En el art. 5 establece que la función del Ministerio del Ambiente (MINAM) 

es desarrollar las políticas, normas, instrumentos y procedimientos generales 

para la ordenación territorial ambiental y ejecutar el proceso en mutuo 

coordinación con los tres niveles de gobierno. Asimismo, el artículo 74 establece 

que es tarea de la Dirección General de Gestión de Residuos Sólidos en el ámbito 

de su competencia, con las autoridades competentes, en caso de ser necesario, 

proponer instrumentos técnicos normativos para la gestión de residuos sólidos.  

2.2.5.3. Variables Temáticos y los Criterios de Selección 

Para identificar las variables temáticas se tiene que tomar como base la 

información cartográfica existente y los requisitos y condiciones establecidas en la 
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normatividad vigente, las cuales formarán parte de las restricciones y exclusiones 

(Rodríguez, 2020). A continuación, detalla las siguientes variables.  

Tabla 3 

Criterios de selección para la instalación de relleno sanitario 

 

ITEM 

 

CRITERIOS DE SELECCIÓN 

LIMITES 

PERMISIBLES 

1 Distancia a centros poblados o viviendas (m) ≥ 500 

2 Distancia a granja (avícolas, porcinos y animales menores  5 a 10 km 

3 Distancia a fuentes de agua superficiales (lagos, lagunas y 

cauce de rio) 

≥ 500 m 

4 Fallas geológicas ≥ 1 km 

5 Vulnerabilidad a desastres naturales   

6 Infraestructuras existentes (obras hidroeléctricas, represas, 

embalses, etc.) 

≥ 500 

7 Distancia a aeropuertos(m) >13 000 

8 Área del terreno (m2)  

9 Vida útil Mínimo 15 años 

10 Pendiente del área  < 25 % 

11 Dirección del viento   

12 Profundidad de la capa freática (m)  

13 Geología del suelo- permeabilidad (m)  

14 Cantidad de material de cobertura   

15 Cuenta con barrera sanitaria natural  

16  Opinión pública   

17 Uso actual del suelo  

18 Accesibilidad de tránsito o vía de acceso  

19 Área natural protegida por el Estado  

20 Área arqueológica  

21 Propiedad del terreno  

22 Distancia a áreas agrícolas ≥ 500 m 

Fuente.  MINAM, (2021). Guía para la identificación de zonas potenciales para 

infraestructura de disposición final de residuos sólidos municipales.  
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2.3 Definición de términos básicos 

2.3.1 Zonas óptimas  

Son áreas delimitadas que cumplen las  condiciones propicias e idóneo para un relleno 

sanitario, que contiene los criterios mínimos y características de sus medios físicos, 

biológicos y socioeconómicos, conforme a la normativa vigente de residuos sólidos  

(MINAM, 2021; Paz, 2023). 

2.3.2 Sistemas de Información Geográfica-SIG 

 Se define como Sistemas de Información Geográfica al sistema de hardware, software y 

procedimientos diseñados para facilitar la obtención, gestión, manipulación, análisis, 

modelado, representación y salida de datos geoespaciales para resolver problemas 

complejos de planificación y gestión (Mancebo et al., 2008). 

Para entender mejor (Olaya, 2014), hace la descripción de subsistemas de SIG, cada uno 

cumpliendo una función:  

Subsistema de datos: Este subsistema es responsable de la gestión de la información 

dentro del sistema de información geográfica (SIG), realizando operaciones de entrada y 

salida de datos. Además, administra el acceso a los datos para permitir que otros 

subsistemas los utilicen en sus respectivas funciones. 

Subsistema de visualización y creación cartográfica: Encargado de la representación 

gráfica de los datos, este subsistema permite generar mapas, leyendas y otros elementos 

visuales que facilitan la interacción con la información geográfica. También incluye 

funcionalidades de edición para modificar los elementos visuales según sea necesario. 

Subsistema de análisis: Este subsistema alberga los métodos y procesos necesarios para 

el análisis de datos geográficos, permitiendo extraer conclusiones y realizar evaluaciones 

espaciales detalladas. 

2.3.2.1 los componentes de la Información geográfica  

Componente espacial: La componente espacial se refiere a la ubicación en un sistema 

de referencia definido. Esta es la característica que permite clasificar la información como 

geográfica, ya que sin esta referencia de localización no se puede situar la información en 

un contexto espacial específico (Olaya, 2014) . 
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Componente temática: Se refiere al contenido específico de los datos que describen las 

características o atributos  del componente espacial, que permite agregar información  

numérica y alfanumérica (Olaya, 2014). 

2.3.2.2. Dimensión de datos Geográficos. 

Olaya (2014) define que la dimensión de datos geográficos, son las características y 

estructuras de información dentro de un sistema de información geográfica (SIG), que 

incluye los tres componentes (espacial, temática y temporal). 

Figura 04:  

Dimensión de datos geográficos 

 

Nota. Figura obtenido del libro Olaya (2014)  

2.3.2.3. Proyecciones Cartográficas  

Ráster  

Organiza el área de estudio dividiéndola en una serie de unidades pequeñas o celdas, en 

las cuales se recolecta información específica para describirlas. Existe una relación 

directa entre la resolución y la precisión en este modelo: a mayor resolución, se obtiene 

una mayor precisión en los datos recolectados. Una ventaja notable del modelo ráster es 

su capacidad para realizar tanto análisis gráficos como estadísticos sobre los datos (ESRI, 

2016). 

vectorial (Shapefile) 

En el modelo vectorial o Shapefile, las áreas no se segmentan en unidades discretas; en 

su lugar, se representan mediante entidades geométricas que capturan su variabilidad y 

sus características específicas. Este modelo describe el espacio geográfico usando 

elementos geométricos como puntos, líneas y polígonos, los cuales representan con 

detalle las características de la superficie terrestre. Cada entidad vectorial, como un punto 

para una estación meteorológica o un polígono para una reserva natural, se define por 

coordenadas espaciales que ubican con exactitud la posición en el entorno real. En el 

ámbito de la ingeniería ambiental, el modelo vectorial es altamente valorado, ya que 
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facilita el análisis espacial, la planificación de uso de suelo, la gestión de recursos y la 

toma de decisiones ambientales informadas, al permitir una representación detallada y 

una manipulación precisa de datos geográficos en sistemas de información geográfica 

(SIG). 

Figura 05 

Representación vectorial (a) y ráster (b) 

 

Nota. Comparación entre los esquemas del modelo vectorial y ráster 

3.3.3. cartografía 

 La cartografía es una ciencia encargada del estudio y de la elaboración de mapas para 

poder representar grandes extensiones del territorio o su totalidad, buscando una relación 

matemática en la que las deformaciones sean reconocibles (Sastre, 2010). 

3.3.4. Proyección cartográfica  

Mancebo et al. (2008) establece que la proyección cartográfica son métodos que se 

emplean para transmitir rangos de la superficie del terreno al papel, es un plano de 

acuerdo con la técnica y metodología. 

3.3.5. Georreferenciación  

Uscamayta  (2021) define la Georreferenciación como el método de establecer la 

ubicación de objetos espaciales en un sistema de coordenadas mediante el uso de puntos, 

líneas o polígonos. Al establecer relaciones entre imágenes rasterizadas y vectoriales en 

un sistema de coordenadas geográficas común, la georreferenciación se aplica a la 

realidad física de las cosas. 

3.3.6. Software ArcGIS  

Con una interfaz gráfica de usuario que se puede utilizar con facilidad, este sistema de 

información geográfica proporciona fácil acceso a datos espaciales y tabulares para 
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mostrarlos en mapas, tablas o gráficos. También ofrece herramientas para el 

análisis/consulta de los datos y la presentación de sus resultados como gráficos tipo mapa 

de calidad de presentación. Se puede obtener es cartografía temática, creación y edición 

de datos, análisis espacial, geocodificación de direcciones, etc. ArcGIS se compone de 

tres aplicaciones que están incluidas en ArcInfo, ArcEditor y ArcView, las cuales son 

ArcMap, ArcCatalog y ArcToolbox. (Collado y Navarro, 2013) 

3.3.7. Evaluación Multicriterio 

 Uscamayta (2021) detalla la evaluación multicriterio como un conjunto de técnicas 

orientadas a ayudar en los procesos de toma de decisiones, que permite estructurar, 

diseñar, evaluar y priorizar alternativas de solución a los problemas mediante la 

evaluación de un conjunto de criterios (cualitativos y cuantitativos), que puede trabajar 

en sinergia con la asignación de valores ordinales o continuos comparables. 

3.3.7.1 Técnicas para realizar el análisis multicriterio  

Existen tres técnicas para realizar el análisis multicriterio según valladares (2022) 

citado por Paz (2023), el cual describe los siguientes: 

Boolean Overlay (superposición booleana): Es una operación que utiliza mapas ráster 

binarios, donde las capas se representan con valores booleanos: 1 para áreas de interés y 

0 para las que no lo son. 

Combinación lineal directa: Este método realiza una evaluación cuantitativa, asignando 

un valor a cada criterio, conocido como "factor," que indica su importancia en la toma de 

decisiones. Para aplicarlo, es necesario estandarizar los factores, ya que pueden tener 

diferentes escalas 

Fuzzy overlay (superposición difusa):  Esta herramienta Permite evaluar la pertenencia 

de criterios en términos de probabilidad, siendo útil cuando los límites entre categorías 

no son claros. Esto es útil en situaciones donde los elementos pueden pertenecer 

parcialmente a varias categorías. 
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III. METODOLOGÍA  

3.1. Enfoque 

El enfoque de la investigación es cuantitativo, debido a que se recolectarán datos, 

para ser analizados en forma numérica. Según Sánchez (2020) define a la investigación 

cuantitativo aquel que se basa en los aspectos numéricos para investigar, analizar y 

comprobar información de datos. Por ende, la investigación se basa en recolectar datos 

cartográficos para luego ser llevados a un programa de ArcGIS y, analizados mediante la 

evaluación multicriterio para obtener mapas temáticos de sitios óptimos para la 

instalación de los rellenos sanitarios.  

3.2. Tipo, nivel y diseño de investigación   

3.2.1. Tipo de investigación  

El tipo de la investigación es aplicada, porque tiene como propósito de dar 

solución a problemas concretos e identificables. La investigación parte del conocimiento 

generado por la investigación básica, tanto para identificar problemas sobre lo que se debe 

intervenir como para definir estrategias de solución. (Huaire, 2019) 

3.2.2. Nivel de investigación 

El estudio es de nivel descriptivo, dado que los datos fueron recolectados y 

analizados mediante herramientas de análisis geoespacial en el distrito de Pichari, 

considerando criterios para la identificación de sitios óptimos para la instalación de los 

rellenos sanitarios. Hernández y Mendoza (2018) considera al nivel descriptivo como un 

propósito que busca medir o recopilar información y presentarla dentro de un marco 

definido por conceptos y operacionalizaciones vinculadas con la fenomenología del 

fenómeno bajo estudio. 

3.2.3. Diseño de investigación  

El diseño de la investigación es no experimental, corte transversal. Ya que los 

datos fueron recolectados una sola vez y no se manipularon no se controló los variables. 

El diseño de corte transversal se clasifica como un estudio observacional de base 

individual que suele tener un doble propósito (descriptivo y analítico), este diseño permite 

examinar y describir cómo se presentan ciertas variables o características en una 

población específica en un instante particular, sin hacer seguimiento a lo largo del tiempo. 

(Hernández y Mendoza, 2018). 
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3.2. Ámbito temporal y espacial  

3.2.1. Ámbito temporal  

La presente investigación se desarrolló durante 1 año, iniciando en julio de 2024 y 

finalizando en agosto de 2025, tiempo durante el cual se realizaron las etapas de 

recolección y análisis de datos geoespaciales, así como la identificación, evaluación de 

áreas potenciales para la instalación del relleno sanitario y validación en campo. 

3.2.2. Ámbito espacial 

3.2.2.1. Ubicación Política  

Región :  cusco  

Provincia :  La Convención 

Distrito :  Pichari   

3.3.2.2. Ubicación geográfica 

El distrito de Pichari, está situada en la parte sur y el flanco oriental de los andes peruana 

y la selva alta. Ubicada en las vertientes montañosas del Valle de los Ríos Apurímac Ene 

y Mantaro (VRAEM), con coordenadas geográficas de 12°34´26.63” latitud sur/ Este 

74°33´35.75” longitud oeste/Norte, coordenadas UTM 18L 656440 mE 8994478 mN y, 

con altitudes que varían desde los 475 msnm hasta 4200 msnm. 
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Figura 6 

Mapa de ubicación de zona de estudio 
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3.3.2.3. Limites  

El distrito de Pichari presenta límites con distritos de los departamentos de 

Ayacucho y Junín, los cuales son:  

Norte: Distrito de rio tambo, provincia Satipo departamento de Junín. 

Sur: Distrito de Kimbiri, provincia La Convención, departamento Cusco 

Este: Distrito de Echarate, provincia La Convención, departamento Cusco 

Oeste:  Distritos de Llochegua, Sivia y Canayre, provincia de Huanta, departamento de 

Ayacucho; Vizcatan del Ene, provincia Satipo departamento de Junín. 

3.3. Población y muestra 

3.3.1. Población 

 Por la peculiaridad de la investigación la población se considera al espacio 

geográfico del distrito de Pichari, provincia la convención, departamento cusco, cuya 

capital del distrito se ubica en una altitud de promedio de 600 m.s.n.m. 

3.3.2. Muestra  

Con la finalidad de identificar áreas óptimas para la instalación de un relleno 

sanitario, se tomó como muestra el área de la población, que tiene una superficie de 

116417.292 ha., el cual posee 11 centros poblados (Catarata, Puerto Mayo, Omaya, 

Tambo del Ene, Nuevo Progreso, Natividad, Nuevo San Cristóbal, Quisto central, Pichari 

Colonos, Otari San Martin y Ccatun Rumi). 

3.4. Instrumentos  

Consiste en abordar la técnica de manejo del ArcGIS 10.8, para ello se aplicó el 

método de análisis de superposición y la técnica de evolución multicriterio que permitió 

la asignación de ponderación del contenido cartográfico obtenidos del (Ministerio del 

Ambiente (MINAM), el Instituto Geográfico Nacional del Perú-IGN, ANA, INEI, 

SERNANP, MINCUL, MTC, MIDAGRI, INDECI Y ZEE de la Municipalidad de 

Pichari), de acuerdo  a los criterios establecidos en la norma y la Guía para la 

“Identificación de Zonas Potenciales para Infraestructura de Disposición Final de 

Residuos Sólidos Municipales, 2021-MINAM”.  

Para el trabajo de investigación se utilizaron los siguientes instrumentos:  
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❖ Software ArcGIS 10.8: Se utilizó ArcGIS 10.8 para realizar diferentes procesos 

de geoprocesamiento y análisis espacial, aplicando el método de análisis de 

superposición y la técnica de evaluación multicriterio. Los pasos realizados 

incluyeron: 

1. Procesamiento de datos: una vez realizado la descarga del contenido 

cartográfico se realiza la preparación de capas temáticas que consiste en la 

generación de base de datos. 

2. Conversión de Formato: Con la herramienta Feature to Raster, se 

transformaron datos en formato vectorial (shape) a formato raster, permitiendo 

el procesamiento de los datos en celdas y facilitando el análisis. 

3. Booleano Overlay (superposición boleana) consistió en codificar cada uno 

de los criterios evaluados con los valores de 1 y 0, donde 1 representa las áreas 

aptas y 0 áreas no aptas, el producto resultante será un mapa de salida 

codificado. 

4. Mapa de Restricciones: Utilizando la herramienta de buffers, se generaron 

zonas de influencia alrededor de áreas sensibles, tales como fuentes de agua y 

zonas urbanas, de acuerdo con la normativa vigente, para delimitar áreas no 

aptas para rellenos sanitarios. 

5. Superposición de Mapas Temáticos: Finalmente, se superpusieron de los 

mapas de exclusiones y restricciones para identificar las áreas potenciales de 

instalación de rellenos sanitarios en función de los criterios establecidos. 

❖ Google Earth Pro: Este software de visualización satelital fue empleado como 

una herramienta de apoyo para el análisis preliminar de accesibilidad y 

proximidad a centros poblados e infraestructuras principales. Google Earth Pro 

permitió visualizar las ubicaciones propuestas en contexto y realizar mediciones 

de distancias para validar la viabilidad de acceso, complementando así el análisis 

espacial detallado de ArcGIS. La capacidad de importar y trabajar con archivos 

KML y KMZ facilitó la comparación de datos entre plataformas y la verificación 

de accesibilidad en zonas potenciales. 

❖ Sistema de Posicionamiento Global (GPS): Para la etapa de trabajo de campo, 

se utilizó un GPS de navegador para validar las coordenadas de las áreas óptimas 

identificadas en el análisis SIG. Este dispositivo permitió obtener ubicaciones 
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precisas y confirmar en el terreno la factibilidad de las áreas seleccionadas, 

asegurando que las zonas aptas en el análisis de ArcGIS correspondieran a lugares 

accesibles y adecuados para la disposición de residuos sólidos. 

❖ Fuentes de Datos y Mapas Temáticos: La información de entrada para el análisis 

se obtuvo de entidades públicas y privadas, tales como el Ministerio del Ambiente 

(MINAM), el Instituto Geográfico Nacional del Perú-IGN, ANA, INEI, 

SERNANP, MINCUL, MTC, MIDAGRI, INDECI Y ZEE de la Municipalidad 

de Pichari, utilizando datos en formatos vectorial (shape) y PDF. La recolección 

de información y la revisión de estudios previos en bibliografía relacionada 

permitieron enriquecer el análisis con información actualizada y específica del 

área de estudio. 
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 3.5. Procedimientos 

El procedimiento de la investigación consistió en 2 fases gabinete y campo  

Figura 7 

Procedimientos realizados en el proyecto de investigación  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ETAPA I ETAPA III ETAPA II ETAPA IV 

Delimitación del 

área de estudio 

(Distrito Pichari) 

Recopilación de 

información 

cartográfica  

Identificación de 

variables 

temáticos 

Determinación 

del área y el tipo 

relleno sanitario a 

instalar  

 

Revisión de los 

criterios 

establecidos del 

MINAM, para 

rellenos sanitarios 

ANA, INEI, IGN 

SERNANP 

MINCUL, MTC 

INGEMMET, 

MIDAGRI. 

INDECI 

ZEE PICHARI 

• Guía para el 

Diseño y 

Construcción 

de 

Infraestructuras 

para 

Disposición 

Final de 

Residuos 

Sólidos 

Municipales. 

• Guía para la 

Identificación 

de Zonas 

Potenciales 

para 

Infraestructura 

de Disposición 

Final de 

Residuos 

Sólidos 

Municipales 

 

Generación de 

base de datos. 

Mapas temáticos: 

✓ Mapa de Pendiente 

✓ Mapa de fallas geológicas  

✓ Mapa de fuente de agua  

✓ Mapa de áreas naturales protegido por el 

estado 

✓ Mapas de vías de acceso. 

✓ Mapa de sitios arqueológicos 

✓ Mapa de áreas urbanas  

✓ Mapa de aeropuerto  

✓ Uso actual de suelo (agrícola) 

 

Mapa final de sitios óptimos para la 

instalación de rellenos sanitarios en el 

distrito de Pichari  

Contraste en campo los sitios 

óptimos identificados   

Fase de gabinete 

Fase de Campo 

Aplicabilidad de 

la técnica de 

evaluación 

multicriterio.  

Sistematización 

de la información: 

a través de 

ArcGIS  

Análisis de datos 

espacial  
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3.5.1 Fase de gabinete  

La Fase de gabinete consistió en recopilar contenido cartográfico en formato 

vectorial (shapefile), de los diferentes geos servidores nacionales y del ZEE de Pichari, 

revisión de las guías para la instalación de rellenos sanitarios, libros y artículos.  

Asimismo, se instaló el software ArcGIS 10.8. 

Etapa I:  

Delimitación de área de estudio.  

Se realizó la delimitación del área de estudio del proyecto de investigación, 

elaborándose un mapa base del distrito de Pichari a escala 1:100,000. Esta delimitación 

permitió establecer los límites espaciales y temáticos donde se enfocó el análisis, 

garantizando que los recursos y esfuerzos se dirigieran específicamente a los aspectos 

más relevantes. 

Revisión de los criterios establecidos del MINAM, para rellenos sanitarios. 

Para identificar los sitios óptimos para la instalación de los rellenos sanitarios, es 

necesario revisar y seleccionar los criterios técnicos establecidos en la “Guía para la 

Identificación de Zonas Potenciales para Infraestructura de Disposición Final de Residuos 

Sólidos Municipales, 2021-MINAM” y “Guía para el Diseño y Construcción de 

Infraestructuras para Disposición Final de Residuos Sólidos Municipales”. 

Etapa II 

La recolección de información cartográfico y satelital se recolecto de diferentes 

fuentes de geo servidores de a nivel nacional (Ministerio del Ambiente (MINAM), el 

Instituto Geográfico Nacional del Perú-IGN, ANA, INEI, SERNANP, MINCUL, MTC, 

MIDAGRI, INDECI) y local (ZEE PICHARI), en formatos de PDF y shape. De acuerdo 

con los criterios seleccionados de la guía. 
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Tabla 4 

Información geoespacial de entidades publicas 

FACTORES DETALLE FUENTE 

Limites  Limite político del distrito INEI 

Áreas urbanas Centro poblados y ciudades INEI, ZEE Pichari 

Vías de acceso Nacional, departamental y 

vecinal 

ZEE Pichari, MTC 

Pendientes  Pendientes de distrito IGN 

Fallas geológicas Distancia a fallas geológicas IGN 

Hidrografía  Ríos, quebradas y riachuelos ANA 

Áreas Naturales Protegidas 

por el Estado-ANP 

ANP, ACR y zonas reservas SERNAMP 

Sitios arqueológicos Patrimonio cultural MINCUL 

Aeropuerto Aeródromos y pistas de 

aterrizaje  

Imagen satelital 

ZEE Pichari 

Uso actual de suelo  agricultura ZEE Pichari. 

 La Tabla 4 presenta las entidades oficiales de las cuales se obtuvo la información 

geoespacial utilizada para el análisis territorial. Estos datos provienen de instituciones 

reconocidas como INEI, IGN, ANA, SERNANP, MINCUL, MTC y la ZEE Pichari, lo 

que garantiza que la base cartográfica empleada sea confiable y actualizada. La selección 

de estos factores (pendientes, hidrografía, fallas, áreas urbanas, ANP, entre otros) 

Generación de base de datos 

Para el Procesamiento de datos en formato (shapefile) los criterios seleccionados 

centros poblados, vías de acceso, pendientes, fallas geológicas, ríos, áreas naturales 

protegida por el estado, sitios arqueológicos y aeropuerto fueron recortados de acuerdo 

con el límite del área del distrito de Pichari para el momento de superponer las capas 

temáticas. 
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Etapa III 

Identificación de variables temáticos 

Para identificar las variables temáticas se tuvo que tomar como base la 

información cartográfica existente y los requisitos y condiciones establecidas en la 

normatividad vigente, las cuales formarán parte de las restricciones y exclusiones 

 

Tabla 5 

Restricciones y exclusiones establecidos en los criterios de ubicación para 

infraestructura de residuos sólidos municipales. 

Requisitos 

para 

identificar 

áreas aptas 

para relleno 

sanitario 

 

Variables 

 

Limites 

permisibles  

 

 

 

Restricciones 

▪ Centros poblados  ▪ ≥ 500 m 

▪ Aeropuerto ▪ ≥ 13 km 

▪ Fuentes de aguas superficiales  ▪ ≥ 500 m 

▪ áreas agrícolas ▪ ≥ 500 m 

▪ Fallas geológicas ▪ ≥ 1 km 

▪ Pendientes  ▪ <25 % 

 

 

 

Exclusiones 

o Áreas Naturales Protegidas por el 

estado 

 

o Peligros por desastres naturales 

(deslizamientos) 

 

o Zonas de turberas, pantanos, humedales 

o recarga de acuíferos 

 

o Faja marginal de rio.  

o Preservación de patrimonio cultural  

o Concesiones mineras, petroleras (en 

explotación) 

 

o Propiedad de comunidades campesinas  

Fuente.  MINAM, (2021). Guía para la identificación de zonas potenciales para 

infraestructura de disposición final de residuos sólidos municipales.  
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Aplicabilidad de la técnica de Evaluación Multicriterio 

Para la identificación de un sitio óptimo para el relleno sanitario, se utilizó la 

técnica de evaluación multicriterio, la cual permitió analizar diversos factores en función 

de su relevancia y adecuación. Para ello, se asignaron valores de ponderación a cada 

factor de selección como "apto" con un valor de 1 y "no apto" con un valor de 0. Esta 

asignación se llevó a cabo considerando la descripción detallada de cada una de las 

características que definen la idoneidad del terreno como indica la Guía “Para el Diseño 

y Construcción de Infraestructura para Disposición final de Residuos Sólidos 

Municipales” y “Guía para la Identificación de Zonas Potenciales para Infraestructura de 

Disposición Final de Residuos sólidos Municipales”.   

Sistematización de la información: a través de ArcGIS 10.8 superposición booleana 

En esta etapa, se llevó a cabo la sistematización de la información utilizando el 

software ArcGIS 10.8, aplicando el método Boolean Overlay (superposición booleana) 

para el análisis multicriterio. Este método permitió procesar los datos obtenidos de 

manera eficiente y estructurada, facilitando la integración y evaluación de los diferentes 

criterios de selección previamente definidos. Asignando valores de aptas (1) o no aptas 

(0) de acuerdo con los valores asignados de los factores restricciones y exclusiones 

(población, vías de acceso, pendientes, fallas geológicas, hidrografía, áreas naturales 

protegidas por el Estado, sitios arqueológicos y aeropuerto).   

Etapa IV 

Determinación del área para relleno sanitario y el tipo de relleno a instalar  

La estimación del área requerida para un relleno sanitario se realiza mediante 

cálculos matemáticos, considerando el volumen de residuos sólidos generado y el periodo 

de vida útil proyectado para la infraestructura, conforme a los lineamientos establecidos 

en la guía para el diseño, construcción, operación, mantenimiento y clausura de rellenos 

sanitarios. 

a. Proyección de Crecimiento poblacional  

Formula 1:  

 

 

Donde:  

Pf= Población futura  

Pf= 𝑝0(1 + 𝑟)𝑛 
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P0= población actual  

r= Tasa de crecimiento poblacional  

n= Tfinal- T inicial 

b. Producción per cápita de residuos solidos 

La producción per cápita en el distrito de Pichari es de 0.657 kg/hab/dia (ECCRSM, 

2022). 

c. Producción diaria y anual de residuos solidos 

Formula 2:  

Donde:  

DSd= Residuos generados diariamente (kg/dia)  

Pob= población 

Ppc= Producción per cápita (kg/hab/dia) 

DSa= Residuos generados anual (Tn/año) 

Producción diaria  

 

Producción anual  

 

 

 

d. Volumen de los residuos sólidos compactados  

Formula 3 

Donde:  

Drsm= densidad de los residuos sólidos recién compactados (238.17 kg/m3) 

VRCd= Volumen de residuos compactado diario(m3/dia) 

VRCa= Volumen de residuos compactado anual (m3/año) 

Volumen de residuos compactado diario 

 

 

Volumen de residuos compactado diario 

 

 

 

DSd = 𝑝𝑜𝑏 ∗ 𝑝𝑝𝑐 

DSa = 
𝐷𝑆𝑑

𝑘𝑔/𝑑𝑖𝑎
∗

𝐴Ñ𝑂

365 𝑑𝑖𝑎𝑠
∗

𝑇𝑛

1000𝑘𝑔
 

VRCd = 
𝐷𝑆𝑑

𝐷𝑟𝑠𝑚
 

VRCa = 𝑉𝑅𝐶𝑑 ∗ 365 
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e. Volumen de material de cobertura y volumen de residuos anual estabilizados 

Formula 4: 

Donde:  

m.c.= Material de cobertura, que representa el 20% de residuos sólidos compactados 

Drsme= densidad de los residuos sólidos estabilizados, que es equivalente a 289.44 

kg/m3 

Ve: Volumen anual estabilizado de residuos solidos 

Material de cobertura  

 

 

Volumen anual estabilizado 

 

 

f. Volumen de material de cobertura y volumen de residuos anual estabilizados 

Formula 4: 

Donde:  

m.c.= Material de cobertura, que representa el 20% de residuos sólidos compactados 

Drsme= densidad de los residuos sólidos estabilizados, que es equivalente a 289.44 

kg/m3 

Ve: Volumen anual estabilizado de residuos solidos 

Material de cobertura  

 

 

Volumen anual estabilizado 

 

 

g. Cálculo de área requerida y cálculo del área total  

Formula 5 

Donde:  

Ar = Área requerida (m2) 

Hrs = profundidad promedio del relleno sanitario 

AT = Área Total requerida 

m.c. = 𝑉𝑅𝑆𝐶𝑎 ∗ 0.20% 

Ve = 
𝐷𝑆𝑑

𝐷𝑟𝑠𝑚𝑒
*365dias 

m.c. = 𝑉𝑅𝑆𝐶𝑎 ∗ 0.20% 

Ve = 
𝐷𝑆𝑑

𝐷𝑟𝑠𝑚𝑒
*365dias 
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F    = Factor de aumento de las áreas adicionales se asume el 30% del área a llenar 

VRS = Volumen de relleno sanitario (m3/año) 

Volumen de relleno sanitario  

 

 

Área requerida  

 

 

Área total requerida 

 

 

Fase de análisis espacial   

Se utilizó el software ArcGIS 10.8, en el cual se realizó el análisis espacial 

aplicando la técnica de superposición ponderada que se basó en la integración de 

múltiples criterios de los criterios considerados, Para ello se utilizó la herramienta 

EUCLIDEAN DISTANCE (ArcToolbox > Spatial Analyst Tools > Distance), se 

calcularon las distancias desde cada píxel hasta el punto de origen para cada uno de los 

criterios definidos como restricciones. Posteriormente, mediante RASTER 

CALCULATOR (ArcToolbox > Spatial Analyst Tools > Map Algebra), se procedió a 

ponderar las distintas variables correspondientes a dichos criterios.  

El análisis se efectuó considerando las particularidades de cada criterio, según lo 

establecido en la normativa vigente, para asignar los pesos correspondientes. 

Posteriormente, mediante herramientas de análisis espacial, se superpusieron los mapas 

generados para crear un mapa de criterios de selección. obteniendo como resultado final 

un mapa que identifica las áreas aptas para la instalación de rellenos sanitarios en el 

distrito de Pichari. 

Fase de campo  

Para contrastar y visualizar las áreas identificados mediante el sistema de 

información Geográfica (SIG), se realizó las visitas a campo teniendo en cuenta las 

distancias y los criterios utilizados, con el objetivo de validar los resultados obtenidos en 

el gabinete. 

 

 

VRS = 𝑉𝑒 + 𝑚. 𝑐 

Ar = 
𝑉𝑅𝑆

𝐻𝑟𝑠
 

AT = ∑ +2035
2026 (𝐹 ∗ 𝐴𝑟) 
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IV.  RESULTADOS Y DISCUSIONES  

4.1. Resultados. 

OE1.   Utilizar los criterios de selección que nos permita elaborar mapas temáticos 

para fijar áreas óptimas para la instalación de un relleno.  

 Para el cumplimiento de este objetivo se seleccionaron nueve criterios de 

evaluación: pendiente, áreas naturales protegidas por el estado (ANP), fallas geológicas, 

vías de acceso, áreas arqueológicas, población, áreas urbanas, aeródromo, áreas agrícolas 

e hidrografía. La selección de estos criterios se basó en las disposiciones técnicas del 

MINAM, la “Guía para el Diseño y Construcción de Infraestructuras para Disposición 

Final de Residuos Sólidos Municipales” y la propuesta de “Guía para la identificación de 

zonas potenciales para infraestructura de disposición final de residuos sólidos 

municipales”, además del marco legal del D. Leg. N.° 1278 y su reglamento. 

Tabla 6 

Criterios seleccionados para elaborar mapas temáticos  

Ítem Criterios de selección Restricciones y exclusiones 

C1 pendiente Pendientes menores a 25%  

C2 ANPs El terreno no debe estar ubicado en un área natural 

protegido por el estado. 

C3 Fallas geológicas  No estar ubicada en zonas con presencia de fallas 

geológicas, para lo cual considerar el terreno a mayor 

de un 1km. 

C4 Vías de acceso Ubicarse a una distancia considerable de vías 

principales para no generar gastos a la municipalidad. 

C5 Áreas arqueológicas El área de terreno no debe estar ubicada en zonas 

arqueológicas, a fin de conservar el patrimonio 

cultural. 

C6 Áreas urbanas Ubicarse a una distancia no menor a 500 metros de 

poblaciones. 

C7 Aeródromo  Se debe considerar 13 km de radio con centro de punto 

de referencia de la pista de aterrizajes. 

C8 Áreas agrícolas  Distancia a áreas donde se desarrollan actividades 

económicas (áreas agrícolas) mayor o igual a 500 

metros. 

C9 Hidrografía No estar ubicadas a distancias menores de 500 metros 

de fuentes de aguas superficiales. 

Nota. Los criterios fueron considerados de acuerdo con la Guía de Diseño y Construcción 

de Infraestructuras para Disposición Final de residuos sólidos Municipales. 
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Figura 8 

Criterios de selección utilizados para la elaboración de mapas temáticos.  

 

La figura 8 muestra los nueve criterios utilizados para la elaboración de los mapas 

temáticos ver anexo 2, Cada criterio presenta una frecuencia de uso igual a uno, lo cual 

confirma que ninguno fue excluido y que todos los elementos definidos en la Tabla 6 

fueron considerados íntegramente en el análisis. Esta representación permite observar que 

los criterios de pendiente, ANP, fallas geológicas, vías de acceso, área arqueológica, 

población, distancia a pistas de aterrizaje, áreas agrícolas e hidrografía fueron empleados 

como insumos fundamentales para la identificación preliminar de áreas óptimas. 

OE2.  Generar base de datos y ponderación basadas en técnica de evaluación 

multicriterio. 

A partir de los criterios seleccionados, se construyó una base de datos espacial 

donde cada criterio fue reclasificado en dos categorías: apta (valor 1) y no apta (valor 

0), empleando la técnica de evaluación multicriterio y superposición booleana en ArcGIS. 

- Categoría Apta (valor = 1): Representa áreas que cumplen con los requisitos 

mínimos dentro de los rangos óptimos definidos para la instalación de un relleno 

sanitario, asegurando condiciones que priorizan la protección de la salud pública y la 

preservación del ambiente. 

- Categoría No Apta (valor = 0): Corresponde a áreas que no cumplen con los 

requisitos mínimos establecidos en la guía, consideradas inadecuadas para la 

ubicación de rellenos sanitarios debido a los riesgos potenciales y los impactos 
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negativos que puede afectar a la sociedad y las fuentes de recursos hídricos. 

Una vez realizado la ponderación de acuerdo con la técnica de evaluación 

multicriterio (tabla 7), los variables fueron llevados al sistema de información geográfica 

- SIG a través de software ArcGIS 10.8. realizando una operación de valorización 

multicriterio de boolean overlay, que consistió en codificar cada uno de los criterios 

evaluados con los valores de 1 y 0, donde 1 representa las áreas aptas y 0 áreas no aptas.   

Tabla 7 

Ponderación de criterios evaluados basadas en la técnica de evaluación multicriterio 

Criterio Categoría Limites permisibles Valor 

pendiente Apta <25% 1 

No apta >25% 0 

Distancia a 

fuentes de agua 

Apta ≥ 500 m 1 

No apta < 500 m 0 

Fallas geológicas Apta ≥1 Km 1 

No apta <1 Km 0 

Áreas agrícolas Apta ≥ 500 m 1 

No apta < 500 m 0 

Distancia a 

población 

Apta ≥ 500 m 1 

No apta < 500 m 0 

Distancias a pistas 

de aterrizaje 

Apta ≥ 13 Km 1 

No apta < 13 km 0 

 

Área arqueológica 

Apta Sin presencia de sitios 

arqueológicos 

1 

No apta Existencia de restos 

arqueológicos 

0 

 

Vías de acceso 

Apta Distancia de vías acceso mayor 

a 500 metros. 

1 

No apta Distancia de vías de acceso 

menor a 500 metros. 

0 

ANPs Apta sin presencia de áreas naturales 

protegidas por el estado ANPS 

1 

No apta Presencia de áreas naturales 

protegidas por el estado ANPS 

0 
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Nota. Esta tabla muestra la ponderación de los criterios establecidos para la ubicación de 

un relleno sanitario asignado valores de apto “1” no apto “0”. 

 

Criterio 1: Pendiente  

Figura 9 

Mapa de espacialización de pendientes  

 

La figura 9 muestra el mapa que representa al análisis de criterio de pendiente 

para la identificación de sitios óptimos para la instalación de un relleno sanitario, el color 

naranja corresponde áreas aptas con pendientes menor de 25%, el cual es favorable para 

la implementación de un relleno sanitario debido a su estabilidad topográfica, menor 

susceptibilidad a la erosión y facilidad para la compactación y manejo de residuos. El 

color verde oscuro representa pendientes superiores al 25%, las cuales son inadecuadas 

para este tipo de infraestructura, estas áreas, incrementa el riesgo de erosión, 

deslizamientos de tierra y filtración de lixiviados, lo que podría comprometer la 

estabilidad estructural del relleno sanitario y generar impactos ambientales adversos. 
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Criterio 2: Fallas geológicas  

Figura 10 

Mapa de ubicación y ámbito de influencia de fallas geológicas 

 

La figura 10 representa el mapa de distancia de fallas geológicas que constituye 

un criterio clave en la determinación de la idoneidad del terreno para la ubicación de un 

relleno sanitario de acuerdo con los valores asignados. El área celeste con asignación de 

valor uno (1) representa a áreas que se encuentran mayor a 1 km, clasificadas como 

potencialmente “aptas” para un relleno sanitario. las áreas de color rojo con asignación 

de valor (0) representa a áreas menores a 1 km, consideradas “no aptas” para la instalación 

de un relleno sanitario. 
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Criterio 3: Red hídrica  

Figura 11 

Mapa de ámbito de influencia de red hídrica  

 

La figura 11 se muestra la distancia a la red hídrica como criterio de selección de 

un sitio óptimo para un relleno sanitario en el distrito de Pichari. las áreas representadas 

en color azul corresponden a sitios “no aptas” para la instalación de un relleno sanitario, 

ya que se encuentran a una distancia menor a 500 metros de una fuente de agua., esta 

restricción busca prevenir la contaminación de los cuerpos hídricos tanto por escorrentía 

superficial como infiltración de lixiviados procedentes de los residuos sólidos. Por otro 

lado, las áreas de color verde son “aptas”, al encontrarse a más de 500 m de la fuente de 

agua, el cual garantiza que la disposición final de los residuos sólidos no genere impactos. 
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Criterio 4: Áreas Naturales protegidos por el Estado – ANPs 

Figura 12 

Mapa de espacialización de Áreas Naturales Protegido por estado 

 

La figura 12 representa la distribución de las Áreas Naturales Protegidos por el 

estado (ANP) dentro del distrito de Pichari, constituyendo un criterio fundamental en la 

identificación de sitios óptimos en la instalación de un relleno sanitario. Las áreas de color 

verde “no aptas” representan a zonas categorizadas como Áreas Protegidos por el Estado, 

las cuales están sujetas a regulaciones estrictas de conservación ambiental, por ello, la 

instalación de un relleno sanitario en estas áreas está completamente excluido  para ello 

se deberá contar con el certificado de no afectación de áreas naturales protegidas emitido 

por el SERNANP.,  De ser inevitable que el terreno a seleccionar se ubique en área natural 

protegida o su área de amortiguamiento, se debe contar con la opinión técnica favorable 

del SERNANP. Por otro lado, el área de color amarillo “aptas” representa a zonas fuera 

de la delimitación de las ANP, donde es viable la instalación de un relleno sanitario. 
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Criterio 5:  Vías de acceso  

Figura 13 

Mapa de influencia de vías de acceso  

 

La figura 13 Se observa el mapa de factor de vías de acceso en función al requisito 

para determinar la idoneidad de un sitio óptimo para un relleno sanitario. Las áreas en 

color verde con asignación de valor “1”, representan a zonas optimas que cumplen con 

los criterios de planificación, mientras que áreas de marrón con asignación de valor “0” 

son consideradas no aptas por ubicarse a menos de 500 metros de las vías, lo que se busca 

con este criterio minimizar los impactos negativos como la visibilidad del sitio y 

dispersión de olores a los visitantes y transeúntes. 
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Criterio 6: Áreas Urbanas  

Figura 14 

Ámbito de influencia de áreas urbanas  

 

La figura 14 se muestra la distribución de áreas urbanas en el distrito de Pichari 

como criterio clave para la ubicación de un sitio óptimo para la disposición final de 

residuos sólidos. Las zonas en color morado representan áreas urbanas y son consideradas 

"no aptas" (valor 0) debido a su proximidad menor a 500 metros de las poblaciones, lo 

que busca prevenir impactos negativos como contaminación ambiental, riesgos sanitarios 

y conflictos sociales. Por otro lado, las zonas en verde son consideradas "aptas" (valor 1) 

para la instalación del relleno sanitario, cumpliendo con la distancia mínima establecida. 

No obstante, el Instrumento de Gestión Ambiental (IGA) puede permitir ubicaciones a 

distancias menores si se justifica técnicamente que los riesgos para la salud y la seguridad 

de la población son controlables, lo que implica un análisis detallado de los factores 

ambientales y socioeconómicos antes de la toma de decisiones. 
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Criterio 7: Aeródromo  

Figura 15 

Ubicación y ámbito de influencia de aeródromo  

 

La figura 15 se evidencia el mapa en función al requisito de localización de 

acuerdo con la distancia de un "Aeródromo"; donde se establece un área de restricción de 

13 km de radio desde el punto medio del aeródromo considerado no apta (valor 0). Fuera 

de esta área, en color verde, el territorio es “apto” (valor 1) para la instalación del relleno 

sanitario. La restricción se debe a la presencia de aves carroñeras atraídas por los residuos, 

lo que aumenta el riesgo de colisiones con aeronaves y posibles accidentes. Este criterio 

sigue normativo de seguridad aeroportuaria para evitar impactos en la aviación y 

minimizar conflictos ambientales en la zona. 
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Criterio 8: Uso de suelos agrícolas 

Figura 16 

Ubicación y ámbito de influencia de áreas agrícolas 

 

La figura 16 representa el mapa de uso de suelos agrícolas en el distrito de Pichari 

para la identificación de un sitio óptimo para un relleno sanitario. Las áreas en negro 

(valor 0), ubicadas a menos de 500 metros de cultivos como piña, cacao, café, arroz y 

coca, se consideran no aptas debido a la posible contaminación del suelo y el agua, 

además del impacto socioeconómico negativo en la producción agrícola. En contraste, las 

áreas en verde (valor 1), que están a más de 500 metros de cualquier zona de cultivo, se 

consideran aptas, ya que no presentan riesgo de afectar la producción agrícola ni generar 

conflictos con los agricultores locales. 
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Tabla 7 

Análisis estadístico descriptivo de los criterios evaluados 

Criterio Área apta 

(1) 

Área no 

apta (0) 

Área total % apta % no apta 

Pendiente 45,399.75 71,017.54 116,417.29 39.00% 61.00% 

Fallas geológicas 73,655.75 42,761.54 116,417.29 63.27% 36.73% 

Red hídrica 62,940.23 53,477.06 116,417.29 54.06% 45.94% 

Áreas agrícolas 105,287.63 11,129.66 116,417.29 90.44% 9.56% 

ANP 31,225.14 85,192.15 116,417.29 26.82% 73.18% 

Aeródromo 87,993.49 28,423.80 116,417.29 75.58% 24.42% 

Áreas urbanas 107,288.39 9,128.90 116,417.29 92.16% 7.84% 

Vías de acceso 94,269.83 22,147.46 116,417.29 80.98% 19.02% 

 Con base en los criterios temáticos evaluados, se cuantificaron las superficies aptas y 

no aptas dentro del ámbito distrital, expresándolas además como porcentaje del área 

total 116,417.292. 

Figura 17 

Distribución porcentual de áreas aptas y no aptas generadas en la base de datos del 

análisis multicriterio 

 

La figura 17 permite visualizar la distribución porcentual de área apta y no apta para cada 

criterio considerado en la evaluación multicriterio, lo que constituye la base fundamental 

para generar la matriz de datos utilizada en el modelo. La variación de los porcentajes 

obtenidos evidencia qué criterios restringen en mayor medida el territorio (como las Áreas 

Naturales Protegidas con 26.82% de aptitud y la pendiente con 39%) y cuáles permiten 
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una mayor disponibilidad de superficie apta (como las áreas urbanas con 92.16% y las 

áreas agrícolas con 90.44%). Esta diferenciación cuantitativa es esencial para generar 

correctamente la base de datos del modelo, que permitió asignar valores binarios de 

aptitud (1 = apto, 0 = no apto) de manera objetiva y sustentada. Asimismo, los porcentajes 

obtenidos sirven como insumo para la posterior ponderación de criterios dentro del 

análisis multicriterio, garantizando que el modelo represente con precisión la influencia 

de cada factor en el territorio. 

 

OE3   Identificar los métodos de relleno sanitario a instalar. 

Cálculo del área y el método de relleno sanitario a instalar en el distrito de Pichari- 

provincia La Convención Cusco 

Para el cálculo del área requerida para un relleno sanitario del distrito de Pichari, los datos 

fueron obtenidos de la caracterización de residuos sólidos de la Municipalidad de Pichari 

(2022) y el INEI del censo del año 2017. 

Los datos obtenidos son:  

Población actual: 22961 hab (INEI-2017). 

Tasa de crecimiento promedio anual: 2.34% (INEI-2017). 

Producción percápita (ppc): 0.657 kg/hab/día (ECCRSM-2022) 

Densidad compactada: 222.99 kg/m3 (ECCRSM-2022) 

a. Proyección de crecimiento poblacional en el distrito de Pichari 

         Formula 1:  

 

 

Pf= Población futura  

P0= población actual  

r= Tasa de crecimiento poblacional  

n= Tfinal- Tinicial 

Pf= 𝒑𝟎(𝟏 + 𝒓)𝒏 
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           Tabla 8 

           Proyección de población en el distrito de Pichari de 2026 al 2035 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

           Figura 18 

           Proyección poblacional del distrito de Pichari  

 

La figura 18 muestra la tendencia creciente de la población proyectada en el distrito 

de Pichari para el periodo 2026–2035, permitiendo identificar un incremento 
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N° Año Formula  Población 
(Hab)  

1 2026 22691(1+0.0234)9 27942 

2 2027 22691(1+0.0234)10 28596 

3 2028 22691(1+0.0234)11 29265 

4 2029 22691(1+0.0234)12 29950 

5 2030 22691(1+0.0234)13 30651 

6 2031 22691(1+0.0234)14 31368 

7 2032 22691(1+0.0234)15 32102 

8 2033 22691(1+0.0234)16 32853 

9 2034 22691(1+0.0234)17 33622 

10 2035 22691(1+0.0234)18 34409 
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continúo asociado a una tasa anual de crecimiento del 2.34 %. Se observa que la 

población aumenta de 27,942 habitantes en 2026 a 34,409 habitantes en 2035, lo que 

representa un crecimiento absoluto de 6,467 habitantes en diez años. 

b. Producción per cápita  

La producción per cápita en el distrito de Pichari es de 0.657 kg/hab/dia 

(ECCRSM-2022). Por lo cual la proyección de la PPC para cada año se 

incrementa en 1%, por lo tanto, este incremento se adopta al crecimiento 

económico distrito impulsado por el canon gasífero, junto con la continua 

migración interna atraída por oportunidades laborales y el aumento en el consumo 

de bienes, contribuyen al incremento progresivo de la generación de residuos por 

habitante. 

            Tabla 9 

            Producción per cápita 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Año Formula ppc 

PPC-2026 0.69 +1% 0.70 

PPC-2027 0.70 + 1% 0.71 

PPC-2028 0.71 +1% 0.72 

PPC-2029 0.72 +1% 0.73 

PPC-2030 0.73 + 1% 0.74 

PPC-2031 0.74 +1% 0.75 

PPC-2032 0.75 +1% 0.76 

PPC-2033 0.76 + 1% 0.77 

PPC-2034 0.77 +1% 0.78 

PPC-2035 0.78 +1% 0.79 
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c. Producción diaria y anual de residuos solidos 

Formula 2:  

Donde:  

DSd= Residuos generados diariamente (kg/dia)  

Pob= población 

Ppc= Producción per cápita (kg/hab/dia) 

DSa= Residuos generados anual (Tn/año) 

Producción diaria  

 

 

Producción anual  

 

 

 

           Tabla 10 

           Generación de residuos sólidos diaria y anual en el distrito de Pichari 

Año Población 
(Hab) 

ppc 
kg/Hab*día) 

DSd 
(kg/día) 

DSa (ton/año) 

PPC-2026 27942 0.70 19559.62 7139.26 

PPC-2027 28596 0.71 20303.28 7410.70 

PPC-2028 29265 0.72 21071.03 7690.92 

PPC-2029 29950 0.73 21863.59 7980.21 

PPC-2030 30651 0.74 22681.71 8278.82 

PPC-2031 31368 0.75 23526.14 8587.04 

PPC-2032 32102 0.76 24397.67 8905.15 

PPC-2033 32853 0.77 25297.11 9233.45 

PPC-2034 33622 0.78 26225.29 9572.23 

PPC-2035 34409 0.79 27183.05 9921.81 

 

 

DSa = 
𝐷𝑆𝑑

𝑘𝑔/𝑑𝑖𝑎
∗

𝐴Ñ𝑂

365 𝑑𝑖𝑎𝑠
∗

𝑇𝑛

1000𝑘𝑔
 

DSd = 𝑝𝑜𝑏 ∗ 𝑝𝑝𝑐 
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             Figura 19 

             Generación diaria de residuos solidos  

 

La figura 19 se muestra la tendencia creciente de la generación diaria de residuos 

sólidos en el distrito de Pichari durante el periodo 2026–2035. Se identifica un 

incremento progresivo desde 19,559.62 kg/día en el año 2026 hasta 27,183.05 

kg/día en 2035, lo que representa un aumento total de 7,623.43 kg/día en diez 

años. Esta tendencia ascendente está asociada al crecimiento poblacional 

proyectado y al incremento gradual del PPC (kg/hab*día). 

d.  Volumen de los residuos sólidos compactados  

Formula 3 

Donde:  

Drsm= densidad de los residuos sólidos recién compactados (238.17 kg/m3) 

VRCd= Volumen de residuos compactado diario(m3/dia) 

VRCa= Volumen de residuos compactado anual (m3/año) 

Volumen de residuos compactado diario 

 

 

Volumen de residuos compactado diario 
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             Tabla 11 

             Volúmenes de residuos compactados  

Año DSd 
(kg/día) 

DSa 
(ton/año) 

Drsm 
(kg/m3) 

VRCd 
(m3/día) 

VRCa 
(m3/año) 

PPC-2026 19559.62 7139.26 238.17 82.12 29975.48 

PPC-2027 20303.28 7410.70 238.17 85.25 31115.15 

PPC-2028 21071.03 7690.92 238.17 88.47 32291.74 

PPC-2029 21863.59 7980.21 238.17 91.80 33506.36 

PPC-2030 22681.71 8278.82 238.17 95.23 34760.14 

PPC-2031 23526.14 8587.04 238.17 98.78 36054.25 

PPC-2032 24397.67 8905.15 238.17 102.44 37389.89 

PPC-2033 25297.11 9233.45 238.17 106.21 38768.30 

PPC-2034 26225.29 9572.23 238.17 110.11 40190.75 

PPC-2035 27183.05 9921.81 238.17 114.13 41658.53 

 

             Figura 20 

            Volumen diario y anual de residuos compactados  

 

La figura 20 permite identificar la tendencia de incremento del volumen diario 

(VRCd) y anual (VRCa) de residuos compactados en el distrito de Pichari durante 

el periodo 2026–2035. Se observa un crecimiento sostenido, pasando de 82.12 

m³/día y 29,975.48 m³/año en 2026 a 114.13 m³/día y 41,658.53 m³/año en 2035. 

Este aumento está directamente relacionado con el incremento de la población y 
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la generación diaria de residuos sólidos. 

e. Volumen de material de cobertura y volumen de residuos anual estabilizados 

El material de cobertura se consideró el 20% del volumen total de residuos 

sólidos, el cual se consideró para cada año y, para determinar volumen anual de 

residuos sólidos estabilizados se dividió los residuos generados diariamente con 

la densidad de los residuos sólidos estabilizados que es de 289.44 según 

ECCRSM-2022 del distrito de Pichari. 

Formula 4: 

Donde:  

m.c.= Material de cobertura, que representa el 20% de residuos sólidos 

compactados 

Drsme= densidad de los residuos sólidos estabilizados, que es equivalente a 

289.44 kg/m3 

Ve: Volumen anual estabilizado de residuos sólidos. 

Material de cobertura  

 

 

Volumen anual estabilizado 

 

 

 

 

 

 

 

 

 

 

 

 

 

m.c. = 𝑉𝑅𝑆𝐶𝑎 ∗ 0.20% 

Ve = 
𝐷𝑆𝑑

𝐷𝑟𝑠𝑚𝑒
*365dias 
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Tabla 12 

Volumen de material de cobertura y volumen de residuos anual estabilizados 

 

Figura 21 

Volumen anual estabilizado de residuos solidos 

 

La figura 21 permite identificar la tendencia creciente del volumen anual estabilizado de 

residuos sólidos (Ve) en el distrito de Pichari para el periodo 2026–2035. Se observa que 
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PPC-2026 19559.62 29975.48 0.2 5995.10 289.44 24665.77 

PPC-2027 20303.27 31115.15 0.2 6223.03 289.44 25603.56 

PPC-2028 21071.03 32291.74 0.2 6458.35 289.44 26571.74 

PPC-2029 21863.59 33506.36 0.2 6701.27 289.44 27571.21 

PPC-2030 22681.70 34760.14 0.2 6952.03 289.44 28602.90 

PPC-2031 23526.14 36054.25 0.2 7210.85 289.44 29667.78 

PPC-2032 24397.67 37389.89 0.2 7477.98 289.44 30766.83 

PPC-2033 25297.12 38768.30 0.2 7753.66 289.44 31901.07 

PPC-2034 26225.28 40190.75 0.2 8038.15 289.44 33071.55 

PPC-2035 27183.05 41658.53 0.2 8331.71 289.44 34279.34 
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el volumen estabilizado aumenta de 24,665.77 m³/año en 2026 a 34,279.34 m³/año en 

2035, lo que representa un incremento acumulado de 9,613.57 m³/año en diez años. Esta 

tendencia refleja el crecimiento progresivo de los residuos generados y compactados, 

sumados al volumen adicional de material de cobertura requerido para la operación del 

relleno sanitario. 

f. Cálculo de área requerida y cálculo del área total  

Formula 5 

Donde:  

Ar= Área requerida (m2) 

Hrs= profundidad promedio del relleno sanitario 

AT= Área Total requerida 

F= Factor de aumento de las áreas adicionales se asume el 40% del área a llenar 

VRS= Volumen de relleno sanitario (m3/año) 

Volumen de relleno sanitario  

 

 

Área requerida  

 

 

 

 

Área total requerida 

 

 

 

 

Se considero para el área total agregar el factor de 30% para los espacios 

complementarios que no están directamente destinados a la disposición de 

residuos, pero que son indispensables: vías de acceso, oficinas, servicios 

higiénicos, almacenes, sistema de drenaje de lixiviados, franjas perimétricas, 

áreas verdes entre otros. Asimismo, se consideró la profundidad de relleno 5 m. 

VRS = 𝑉𝑒 + 𝑚. 𝑐 

Ar = 
𝑉𝑅𝑆

𝐻𝑟𝑠
 

AT = ∑ +2045
2026 (𝐹 ∗ 𝐴𝑟) 
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Tabla 13 

Cálculo del área requerida y el método de relleno sanitario a instalar  

 

Año mc (m3/año) Ve (m3/año) VRS (m3/año) Hrs (m) Ar (m2) FACTOR AT AT/Ha 

PPC-2026 5995.10 24665.77 30660.87 5 6132.17 1.3 7991.8 0.80 

PPC-2027 6223.03 25603.56 31826.59 5 6365.32 1.3 8294.9 0.83 

PPC-2028 6458.35 26571.74 33030.09 5 6606.02 1.3 8607.8 0.86 

PPC-2029 6701.27 27571.21 34272.48 5 6854.50 1.3 8930.8 0.89 

PPC-2030 6952.03 28602.90 35554.93 5 7110.99 1.3 9264.3 0.93 

PPC-2031 7210.85 29667.78 36878.63 5 7375.73 1.3 9608.4 0.96 

PPC-2032 7477.98 30766.83 38244.81 5 7648.96 1.3 9963.6 1.00 

PPC-2033 7753.66 31901.07 39654.73 5 7930.95 1.3 10330.2 1.03 

PPC-2034 8038.15 33071.55 41109.70 5 8221.94 1.3 10708.5 1.07 

PPC-2035 8331.71 34279.34 42611.05 5 8522.21 1.3 11098.9 1.11 

Área requerida total 9.48 Ha 
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Figura 22 

Área proyectada para relleno sanitario 

 

La figura 22 permite identificar la tendencia de crecimiento del área necesaria para la 

disposición final de residuos sólidos durante el horizonte de diseño 2026–2035. Se 

observa un incremento progresivo desde 0.80 ha en 2026 hasta 1.11 ha en 2035, producto 

del aumento del volumen estabilizado de residuos y del material de cobertura requerido. 

Esta evolución evidencia que la demanda espacial del sistema se incrementa de manera 

constante conforme crece la población y la generación de residuos. A partir de los valores 

anuales, se determina un área acumulada mínima de 9.48 hectáreas para garantizar la 

operación del relleno sanitario durante todo el periodo evaluado. Estos resultados 

permiten identificar que los volúmenes proyectados son consistentes con un sistema de 

disposición final de tipo semi–mecanizado, cumpliéndose el OE3 al determinar el área 

técnica necesaria para el diseño del relleno sanitario. 

OE4   Localizar sitios óptimos para la instalación de relleno sanitario.  

Una vez realizado la operación de multiplicación de mapas binarios a través de la 

metodología de la técnica de análisis multicriterio boolen overlay se realizó la 

ponderación de las capas ráster de los 9 criterios, obteniendo como resultado localización 

de sitios óptimos, a continuación, se detalla las áreas aptas y no aptas en el espacio 

geográfico del distrito de Pichari. 
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Figura 23 

Mapa de áreas potenciales para la instalación de los rellenos sanitarios   
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Figura 24 

Mapa de Áreas óptimas para relleno sanitario  

 

En la figura 24 representa un mapa que visualiza las áreas identificadas preliminarmente 

como potencialmente aptas para la ubicación de un relleno sanitario mediante el Sistema 
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de Información Geográfica (SIG). Este mapa destaca, de manera gráfica, las zonas 

geográficas que han sido evaluadas y clasificadas como adecuadas para la instalación de 

un relleno, de acuerdo con los criterios establecidos en la Guía para el Diseño y 

Construcción de Infraestructuras para Disposición Final de Residuos Sólidos 

Municipales. 

Tabla 14 

Áreas identificadas potenciales mediante SIG. 

ÁREAS POTENCIALES PARA LA INSTALACIÓN DE LOS RELLENOS 

SANITARIOS 

ÁREAS 

IDENTIFICADAS ÁREA (ha) 
COORDENADAS UTM 

X Y 

A 5.89 610230.74 8654360.59 

B 7.41 610167.47 8651828.71 

C 7.66 613641.45 8649112.14 

D 11.61 612092.16 8651229.82 

E 12.58 612970.20 8654923.58 

F 18.15 612245.87 8647669.49 

G 21.09 610585.28 8652926.36 

H 22.98 611158.44 8648414.65 

I 31.12 617139.65 8644078.80 

J 35.26 615167.57 8646264.89 

K 47.9 610278.26 8655700.58 

L 51.16 609477.50 8654328.48 

M 65.22 612141.94 8649056.44 

N 146.03 615468.95 8647383.12 

Ñ 171.99 613744.13 8649705.16 
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Figura 25 

Áreas potenciales identificadas 

 

La figura 25 muestra la superficie de las quince áreas potenciales identificadas mediante 

el análisis SIG. Se observa que la mayoría de las áreas presentan superficies menores a 

60 ha; sin embargo, destacan las áreas N (146.03 ha) y Ñ (171.99 ha) por su mayor 

extensión. La identificación de estas superficies permite localizar de manera preliminar 

los sectores con mayor disponibilidad territorial que podrían albergar un relleno sanitario. 

Esta distribución evidencia que, si bien existen varias alternativas posibles, solo algunas 

cumplen con la superficie mínima necesaria de acuerdo con el contraste en el campo.  

 

Detalle de las áreas seleccionadas como optimas según el área requerida, contraste 

en campo  

Se identificaron 15 sitios potenciales para la disposición final de residuos sólidos 

municipales en el distrito de Pichari, mediante el Sistema de Información Geográfica 

(SIG), utilizando el software ArcMap 10.8. Esta evaluación se basó en criterio de 

exclusión y restricciones de las distancias establecidas en la guía. Sin embargo, se observó 

en la salida de campo que solo dos de los sitios evaluados (áreas I y J) presentan para la 

ubicación de infraestructura de disposición final. 

Esta limitación espacial se explica, en gran medida, por las características del 

territorio: aproximadamente el 31 % del distrito de Pichari está cubierto por la Reserva 

Comunal Asháninka y el Parque Nacional Otishi, mientras que un 42 % adicional 
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corresponde a zonas de amortiguamiento, las cuales presentan pendientes elevadas, alta 

biodiversidad y presencia de importantes recursos hídricos, condiciones que restringen 

severamente el uso del suelo para fines de disposición de residuos sólidos. 

Durante el trabajo de campo, se inspeccionaron las áreas codificadas como A, B, 

C, D, E, F, G, H, K, L, M, N y Ñ, las cuales fueron descartadas por incumplir con los 

criterios técnicos establecidos en la Guía para el Diseño y Selección de Sitios de Rellenos 

Sanitarios del Ministerio del Ambiente y otras normas. Entre las principales restricciones 

observadas se incluyen la proximidad a fuentes de agua temporal, presencia de bosques 

primarios, superposición con zonas de conservación regional (vinculadas al proyecto 

IMA), existencia de patrimonio forestal y fauna silvestre, territorios de comunidades de 

etnia Asháninka y la superposición entre región Cusco y Junín, tal como se observa en el 

(anexo 3 y 4). 

Por el contrario, los sitios I y J cumplen con los requerimientos mínimos 

establecidos para la instalación de un relleno sanitario de tipo semi - mecanizado, tanto 

en términos establecidas en la guía, resultando ser las opciones óptimas para su 

implementación de un relleno sanitario. Sin embargo las áreas identificadas como aptas 

para la instalación de un relleno sanitario se encuentran a una distancia considerable del 

centro urbano de Pichari, entre 46 y 48 km, lo que genera una gran limitación para su 

implementación, ya que el traslado diario de los residuos sólidos implicaría un alto costo 

económico para la municipalidad, además de mayores tiempos de transporte, mayor 

consumo de combustible y desgaste vehicular, lo cual hace inviable su operación desde 

el punto de vista técnico y financiero.
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Figura 26 

Áreas con potencial para la instalación de un relleno sanitario visualizados en campo 
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Figura 27 

Áreas seleccionadas y validadas en campo como sitios óptimos para relleno sanitario 
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Tabla 15  

Ubicación de áreas identificadas 

ID Coordenadas  Distancia de la 

ciudad 

Área (ha)  

I 617139.65 8644078.80 48 km 31.12 

J 615167.57 8646264.89 46 km 35.26 

Total    66.38 

Se observa en la tabla 15 las áreas identificadas como óptimas para la implementación de 

un relleno sanitario semi - mecanizado en el distrito de Pichari con respecto a las 

distancias significativas respecto al núcleo urbano, siendo de 48 km para el área “I” y 46 

km para el área “J” lo que constituye una limitación crítica para su viabilidad operativa y 

económica.  

Figura 28 

Área optimas identificadas   

 

La figura 28 muestra las dos áreas óptimas identificadas mediante el análisis SIG, con 

superficies de 31.12 ha para el sitio I y 35.26 ha para el sitio J, sumando un total de 66.38 

ha. Estos sitios cumplen con todos los criterios de la guía para la Identificación de zonas 

potenciales para infraestructura de disposición final de residuos sólidos establecidos por 

el MINAM, lo que confirma el logro del objetivo general al identificar zonas 
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técnicamente aptas para la instalación del relleno sanitario. Sin embargo, si bien ambos 

sitios presentan condiciones físicas favorables, también se observa una limitación crítica 

asociada a su ubicación geográfica: el sitio I se encuentra a 48 km del área urbana de 

Pichari y el sitio J a 46 km. Esta distancia incrementa significativamente los costos 

operativos, el consumo de combustible, el desgaste vehicular y los tiempos de traslado, 

reduciendo su viabilidad práctica para la gestión municipal. Por lo tanto, aunque el 

análisis multicriterio permitió localizar áreas óptimas desde el punto de vista técnico, 

estos sitios no pueden considerarse plenamente viables para la implementación de un 

relleno sanitario debido a sus implicancias logísticas y económicas. 

4.2 Discusiones  

En el presente estudio se determinó la localización óptima para la implementación 

de un relleno sanitario mediante el uso de herramientas de Sistemas de Información 

Geográfica (SIG), tomando como referencia los criterios técnicos establecidos por el 

Ministerio del Ambiente (MINAM), la Guía para el Diseño y Construcción de 

Infraestructuras para la Disposición Final de Residuos Sólidos Municipales, así como la 

Propuesta de Guía para la Identificación de Zonas Potenciales para Infraestructura de 

Disposición Final de Residuos Sólidos Municipales. El análisis se basó en la aplicación 

de una metodología de evaluación multicriterio, considerando nueve variables 

fundamentales: fuentes hídricas, pendiente, fallas geológicas, áreas naturales protegidas 

por el estado, zonas arqueológicas, áreas urbanas, vías de acceso, pistas de aterrizaje y el 

uso actual del suelo (agrícola). Esta evaluación fue complementada con una verificación 

en campo, lo que permitió contrastar los resultados obtenidos en gabinete. Como 

resultado, de los quince sitios inicialmente identificados, solo dos fueron considerados 

viables, debido a que la mayoría de las ubicaciones propuestas se encuentran en zonas de 

superposición (conflicto territorial), principalmente hacia el sector norte del área urbana 

de Pichari. 

Es pertinente comparar los estudios realizado por Loyaga (2019) y Uscamayta 

(2021), quienes seleccionaron los criterios de acuerdo con la Guía de Diseño, 

Construcción, Operación, Mantenimiento y Cierre de Relleno Sanitario Manual - 

mecanizado, estas guías, si bien se centra a cada tipo de diseño a implementar, pero la 

diferencia con la guía actual es que tiene un foque más integral, no solo en rellenos 

sanitarios, sino en toda la infraestructura de disposición final incluyendo criterios para 

toda infraestructura de disposición final (rellenos, celdas transitorias, ampliaciones etc.). 
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Cabe mencionar que la evaluación de las zonas potenciales varía 

significativamente entre regiones, tanto en extensión como en el número de zonas 

identificadas, debido a los variables utilizados, el contexto territorial y la aplicabilidad 

específica de los criterios técnicos definidos por el MINAM. En comparación con Supo 

(2024), en un estudio realizado en la provincia de La Convención, identificó un mayor 

número de zonas aptas, atribuyendo este resultado a una menor densidad de restricciones 

geográficas y a una distribución más homogénea del territorio. Sin embargo, al igual que 

en el presente estudio, se reconoció la importancia de la validación en campo, ya que 

varios sitios seleccionados inicialmente fueron descartados por incompatibilidad con el 

uso actual del suelo o por conflictos con actores locales. 

De manera similar, la investigación de Uscamayta (2021) en la provincia de Cusco 

utilizo la técnica de evaluación multicriterio utilizando los criterios similares, pero 

encontró solo cuatro zonas aptas dentro de un territorio amplio, debido a la alta presencia 

de áreas agrícolas, pendientes pronunciadas y zonas arqueológicas. En su estudio se 

destacó que, aunque el modelo técnico señalaba zonas óptimas, su implementación real 

estaba condicionada por factores socioambientales no cuantificables en el análisis 

espacial, debido algunas limitaciones que no se puede observar en ArcGIS, lo cual hizo 

la validación en campo. 

En comparación con la investigación de Mamani (2020) en el distrito de 

Huayrapata, Puno, donde se utilizaron solo cuatro criterios (pendiente, cuerpos de agua y 

fallas geológicas) procesados en ArcGIS 10.5, el presente estudio en Pichari incorporó 

nueve variables, incluyendo zonas arqueológicas, áreas protegidas, uso agrícola y pistas 

de aterrizaje, lo que hizo más rigurosa la evaluación. Mamani priorizó la cercanía a vías 

de acceso para reducir costos logísticos, logrando identificar cuatro áreas potenciales de 

gran extensión; mientras que, en Pichari, pese a que se identificaron inicialmente quince 

sitios, solo dos fueron viables tras la validación en campo, debido a las mayores 

restricciones territoriales y la superposición de las regiones de Junín y Cusco. Esta 

comparación evidencia que la cantidad y tipo de variables influyen directamente en los 

resultados, y que una mayor exigencia técnica puede reducir el número de zonas óptimas. 

En estudios previos sobre identificación de sitios para la instalación de relleno 

sanitario mediante técnicas de análisis espacial, se han obtenido diversos resultados que 

destacan por su rigor técnico, aunque presentan limitaciones en cuanto a la consideración 

de variables logísticas. Vasquez (2023) identificó cinco sitios óptimos para un relleno 
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sanitario en el distrito de Chota, denominados “Área 3”, “Área 4”, “Área 5” y “Área 6”, 

siendo esta última subdividida en dos zonas validadas (6A y 6B). Por su parte, Paz (2023) 

localizó tres zonas optimas clasificadas según su grado de idoneidad (regular, aceptable 

y óptima) en el distrito de Santa Ana. Asimismo, Uscamayta (2021) logró delimitar cuatro 

áreas con potencial para un relleno sanitario en la provincia del Cusco. Si bien estos 

trabajos aportan información valiosa para la planificación territorial y la gestión 

ambiental, se observa que ninguno de ellos hace mención explícita a la distancia que 

existe entre las áreas seleccionadas y la ciudad (núcleo urbano), aspecto clave para la 

viabilidad operativa y económica de un sistema de disposición final de residuos sólidos. 

A diferencia de dichos estudios, la presente investigación demuestra que, si bien existen 

áreas técnicamente aptas para la instalación de un relleno sanitario, estas se encuentran a 

una distancia considerable (46 a 48 km) del núcleo urbano de Pichari, lo que representa 

una barrera significativa en términos de sostenibilidad financiera para la gestión 

municipal. 
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V.   CONCLUSIONES  

5.1  Se considero nueve criterios claves para la identificación de zonas potenciales 

destinadas a la implementación de un relleno sanitario, considerando variables como 

fuentes hídricas, pendiente, fallas geológicas, áreas naturales protegidas, zonas 

arqueológicas, zonas urbanas, vías de acceso, pistas de aterrizaje y uso actual del 

suelo agrícola. La selección de dichos criterios se desarrolló en base a los 

lineamientos técnicos establecidos por el Ministerio del Ambiente, contenidos en la 

Guía para el Diseño y Construcción de Infraestructuras para la Disposición Final de 

Residuos Sólidos Municipales.  

5.2  La aplicación del análisis multicriterio permitió, en una primera etapa, realizar la 

superposición de las capas temáticas correspondientes a los criterios de restricción, 

considerando los límites establecidos para las variables de centros poblados, pistas 

de aterrizaje, cuerpos de agua (fuentes hídricas), fallas geológicas, pendiente del 

terreno y uso del suelo agrícola. Asimismo, se integraron las capas de exclusión 

correspondientes a áreas naturales protegidas por el estado y zonas arqueológicas. 

Todos estos criterios fueron previamente estandarizados mediante una codificación 

binaria del análisis multicriterio, asignando el valor “1” a las áreas aptas y “0” a las 

no aptas, lo que permitió estructurar una matriz espacial que sirvió de base de datos 

para la identificación de zonas con potencial para la ubicación de un relleno 

sanitario. 

5.3 Para identificar los métodos de relleno a instalar se obtuvo datos de la 

caracterización de residuos sólidos de la Municipalidad de Pichari (2022) y el INEI 

del censo del año 2017., se proyectó el crecimiento poblacional para el periodo 

2026–2035, estimando que la población alcanzará aproximadamente los 34409 

habitantes al año 2035, generando un incremento en la producción anual de residuos 

sólidos municipales desde 7139.26 toneladas en 2026 hasta 9921 toneladas en 2035. 

Con base en dichas proyecciones y considerando los parámetros técnicos 

establecidos para el diseño de infraestructura de disposición final, se calculó que el 

área requerida para la implementación de un relleno sanitario con horizonte de 

planificación de 10 años asciende a 9,48 hectáreas. En función de esta dimensión, 

se concluye que el tipo de tecnología para su construcción corresponde a tipo de 

relleno semi - mecanizado, que garantice una adecuada operatividad, eficiencia y 

sostenibilidad ambiental en la gestión de los residuos sólidos municipales del distrito 
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de Pichari. 

5.4 Mediante el análisis espacial en gabinete, utilizando el Sistema de Información 

Geográfica (SIG), se identificaron quince (15) áreas preliminares con superficies 

superiores a 5 hectáreas para la localización de un relleno sanitario en el distrito de 

Pichari; sin embargo, la validación en campo permitió descartar la mayoría de estos 

sitios por no cumplir con los criterios técnicos establecidos en la normativa nacional, 

tales como la proximidad a fuentes hídricas, presencia de bosques primarios, 

superposición con áreas de conservación regional (IMA), limitaciones de 

accesibilidad vial, ubicación en territorios de comunidades Asháninka y la 

superposición territorial entre las regiones Cusco y Junín, determinándose que 

únicamente los sitios I (31.12 ha) y J (35.26 ha) reúnen los requerimientos mínimos 

para considerarse alternativas viables. No obstante, la distancia entre estas áreas y 

el centro urbano de Pichari (46 a 48 km) representa una limitación crítica para su 

implementación, ya que el traslado diario de residuos sólidos implicaría elevados 

costos económicos, mayores tiempos operativos, un significativo consumo de 

combustible y desgaste vehicular, factores que en conjunto comprometen la 

viabilidad técnica y financiera del proyecto. En este contexto, al considerar que el 

distrito posee una extensión territorial de 116,417.292 hectáreas, se identificó que 

únicamente el 0.057 % del área total presenta condiciones óptimas para la instalación 

de un relleno sanitario semi-mecanizado, lo que evidencia la reducida disponibilidad 

de suelos adecuados y refuerza la necesidad de una evaluación rigurosa que integre 

criterios ambientales, normativos y de planificación territorial, a fin de garantizar la 

sostenibilidad y viabilidad de este tipo de infraestructura en el largo plazo. 
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VI.  RECOMENDACIONES 

6.1  Para la planificación de la ubicación de un relleno sanitario en el distrito de 

Pichari, resulta fundamental considerar que los sitios identificados como 

óptimos (sitio I con 31,12 ha y sitio J con 35,26 ha) se encuentran en áreas 

alejadas de la ciudad (núcleo urbano), lo que implica mayores costos logísticos 

y operativos en el transporte de residuos hasta el centro poblado de Natividad. 

Frente a esta condición, se recomienda a la Municipalidad Distrital de Pichari 

gestione la opinión técnica vinculante de las entidades competentes y, de manera 

excepcional, solicite a la autoridad ambiental la evaluación de posibles 

alternativas de localización que contemplen distancias menores a las 

establecidas en la Guía Técnica, siempre que se garantice el cumplimiento de 

los lineamientos del Instrumento de Gestión Ambiental (IGA) y las medidas de 

seguridad en relación con las áreas de amortiguamiento de las Áreas Naturales 

Protegidas (ANP), cuerpos de agua, aeródromos y áreas urbanas. 

6.2 Una vez obtenidos los resultados preliminares del modelo de identificación de 

zonas potenciales mediante análisis en gabinete, es necesaria una evaluación 

complementaria en campo para validar y seleccionar la mejor alternativa de 

localización para la infraestructura de disposición final de residuos sólidos 

municipales. Asimismo, se recomienda que la institución pública, antes de 

definir el sitio final, realice estudios sobre condiciones climáticas, análisis de 

suelo, flora y fauna, así como estudios sociales, con el propósito de prevenir 

conflictos posteriores. 

6.3  Se recomienda que el presente estudio sea considerado como un insumo técnico 

de referencia para la futura implementación de un relleno sanitario en el distrito 

de Pichari, dado que proporciona una base geoespacial validada mediante 

análisis SIG. Asimismo, los resultados obtenidos pueden ser utilizados en 

procesos de planificación territorial relacionados con el centro poblado de 

Natividad, el cual se encuentra en proceso  de distritalización bajo la 

denominación de “distrito Tambo del Ene”, contribuyendo así a una gestión 

anticipada y sostenible de los residuos sólidos en dicha jurisdicción emergente. 
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VIII. ANEXOS 

Anexo 1: Matriz de consistencia 

Problema Objetivo Hipótesis Variable Metodología 

Interrogante general  Objetivo general   Variable dependiente  

¿Cuáles son los sitios que cumplan las 

condiciones óptimas para la instalación de 

un relleno sanitario, mediante SIG, en el 

distrito de Pichari, provincia la 

convención - Cusco? 

Identificar áreas óptimas para la 

instalación de relleno sanitario 

utilizando el Sistema de 

Información Geográfica (SIG), en el 

distrito de Pichari - Provincia La 

Convención- Cusco.  

Hipótesis nula (H0). No existirá 

alguna área potencial que reúna 

las condiciones adecuadas para 

la instalación de relleno sanitario 

Hipótesis alternativa (H1). 

Existirán sitios potenciales que 

reúnan las condiciones 

adecuadas para la instalación de 

un relleno sanitario. 

 

Identificación de áreas 

óptimas para la 

instalación de relleno 

sanitario. 

 

Variable 

independiente 

Sistema de información 

geográfica 

 

 

ENFOQUE DE LA 

INVESTIGACIÓN  

Cuantitativo 

 

TIPO DE 

INVESTIGACIÓN  

Aplicada  

 

NIVEL DE 

INVESTIGACIÓN 

Descriptivo  

 

DISEÑO DE 

INVESTIGACIÓN  

No experimental, 

transversal. 

 

INSTRUMENTOS  

- Software ArcGIS 

10.8. 

- Google Earth Pro. 

- Sistema de 

Posicionamiento 

Global (GPS). 

- Fuentes de Datos y 

Mapas Temáticos. 

 

Interrogantes específicos  

1. ¿Cuáles son los criterios de selección 

que nos permita elaborar mapas 

temáticos para fijar zonas apropiadas 

para la instalación del relleno sanitario? 

2. ¿Qué datos de ponderación se le 

otorgará según la técnica de evaluación 

multicriterio? 

3. ¿Cuál es el tipo de relleno sanitario a 

instalar en el distrito de Pichari? 

4. ¿Cuáles serán los sitios óptimos para la 

instalación de un relleno sanitario 

mediante el SIG? 

Objetivos específicos  

1. Utilizar los criterios de selección 

que nos permita elaborar mapas 

temáticos para fijar áreas óptimas 

para la instalación de un relleno.  

2. Generar base de datos y 

ponderación basadas en técnica de 

evaluación multicriterio. 

3. Identificar el tipo de relleno 

sanitario a instalar. 

4. Localizar sitios óptimos para la 

instalación de rellenos sanitarios 

mediante el SIG. 
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Anexo 2:  Datos obtenidos del geo servidores del estado  

Figura 29 

Información cartográfica de pendientes del distrito de Pichari 
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Figura 30 

Información geográfica de fallas geológicas del distrito de Pichari 
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Figura 31 

 Información geográfica de red hídrica del distrito de Pichari 
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Figura 32 

Información geográfica de Áreas Naturales protegidas por el estado (ANP), en el distrito de Pichari 
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Figura 33 

Información geográfica de vías de acceso del distrito de Pichari 
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Figura 34 

Información geográfica de sitios arqueológicos en el distrito de Pichari 
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Figura 35 

Información geográfica de áreas urbanas 
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Figura 36 

Información geográfica de mapa del aeródromo del distrito de Pichari 
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Figura 37  

Información geográfica de uso actual de suelo en el distrito de Pichari  
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Anexo 3:  Panel fotográfico (validación en campo). 
 

Figura 38  

Validación de campo del área Ñ, comunidad nativa Gran Shinungari. 

 

 
 

Figura 39 

Validación de campo del área C 
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Figura 40 

Presencia de diversidad especímenes de fauna silvestre en áreas N, C, F, M y H, territorios de 

comunidad asháninca Catungo Quimpiri y Gran Shinungari 

 

 
 

Figura 41 

Validación de campo en el área N, presencia de fuentes hídricas  

 

 
 



106 

 

 

Figura 42 

Validación de campo de área Ñ, diversidad de flora. 

 
 

Figura 43 

Validación de campo de área B 
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Figura 44 

Validación de campo del área F, territorio de CC. NN Gran Shinungari 

 

 
 

Figura 45 

Área F, presencia de variedades de flora y fauna (bosque primario) 
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Figura 46 

validación de campo en zona fronterizo entre el distrito de Pichari (cusco) y Rio Tambo 

(Junín). 

 

 

Figura 47 

Validación de campo área D, zona de conflicto territorial entre las regiones Cusco y Junín 
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Figura 48 

Validación de campo del área L, zona de alta densidad de bosque  

 

 

Figura 49 

Validación de campo de área A, G, L, K y E, zona de fronterizo con conflicto territorial entre 

las regiones de Junín y Cusco. 
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Figura 50 

Vía de acceso principal a centro Poblado de Natividad  

 
  

Figura 51 

Puesto de Salud de Natividad  
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Figura 52 

Fuente hídrica ubicado fuera del polígono de las áreas I y J a más de 1000 m. 

 

Fotografía 53 

Vista panorámica del centro poblado de Natividad  
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Figura 54 

Validación de campo del área j 

 

 
 

Figura 55 

Validación de campo área I, existencias de vías de acceso  
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Figura 56 

Vista panorámica del área I, desde otro extremo del lugar   

 
 

Figura 57 

Validación de campo área j 
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Anexo 4: Imágenes satelitales desde Google Earth 

Figura 58 

Vista desde Google Earth de los sitios localizados para la ubicación de un relleno sanitario 
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Anexo 5: Figuras que muestran el procedimiento de la evaluación multicriterio en el 

software ArcGIS 10.8 

 

Criterio 1: Pendientes 

Figura 59 

Curvas de nivel en formato vectorial 

 
 

Figura 60 

Modelo Digital de Elevación (MDE) generado mediante interpolación Topo to Raster a 

partir de curvas de nivel 

 

Nota. Procesos utilizados en ArcMap: ArcToolbox → 3D Analyst Tools → Raster 

Interpolación → Topo to Raster; se utilizó la capa de curvas de nivel (formato vectorial) 

con el campo de elevación como variable de entrada para generar el MDE en formato 

ráster, representando la variación altitudinal del terreno. 
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Figura 61 

Ponderación binaria (0,1) del criterio de pendientes 

Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Surface → Slope, 

para generar el mapa de pendientes a partir del modelo digital de elevación (MDE). 

Posteriormente, se aplicó ArcToolbox → Spatial Analyst Tools → Map Algebra → 

Raster Calculator, utilizando la expresión Con ("slop.tif" < 25, 1, 0) para reclasificar el 

ráster y obtener las áreas aptas (1) y no aptas (0) según el umbral de pendiente establecido 

(<25 %). 

Criterio 2: Fallas geológicas 

Figura 62 

Conversión de la capa de fallas geológicas a formato ráster mediante Polyline to 

Raster 

 
Nota. Procesos realizados: ArcToolbox → Conversion Tools → To Raster → Polyline to 

Raster; se empleó la capa vectorial de fallas geológicas como entrada, asignando el campo 

de identificación correspondiente para generar un ráster de líneas, necesario para la 

aplicación de análisis de distancia y la ponderación binaria (0,1) en la evaluación 

multicriterio. 
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Figura 63 

Cálculo de la distancia euclidiana a fallas geológicas. 

Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Distance → 

Euclidean Distance; se empleó el ráster de fallas geológicas como entrada para calcular 

la distancia en metros desde cada celda hacia la falla más cercana. 

 

Figura 64 

Ponderación binaria (0,1) del criterio de fallas geológicas mediante Map Algebra 

(Raster Calculator) 

 
Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Map Algebra → 

Raster Calculator; se reclasificó el raster de distancia euclidiana a fallas con la expresión 

tipo Con ("Fallas_ distance" > 1000 mts,1,0) 
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Figura 65 

Recorte del ráster de distancia a fallas geológicas mediante la herramienta Extract by 

Mask. 

 
Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Extraction → Extract 

by Mask (CC2- limite distrital pichari); se utilizó el límite distrital de Pichari como 

máscara para delimitar el área de análisis, extrayendo únicamente la zona correspondiente 

al ámbito de estudio y optimizando los resultados del criterio de fallas geológicas en la 

evaluación multicriterio. 

 

Criterio 3: Fuentes hídricas 

Figura 66 

Conversión de la red hídrica a formato ráster mediante la herramienta Polyline to 

Raster 

 
Nota. Procesos realizados: ArcToolbox → Conversion Tools → To Raster → Polyline to 

Raster; se utilizó la capa vectorial de red hídrica (ríos y quebradas) como entrada, 

asignando el campo de identificación correspondiente para generar un ráster de líneas 

hidrológicas 
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Figura 67 

Cálculo de la distancia euclidiana de fuentes hídricas 

 

Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Distance → 

Euclidean Distance; se empleó el río_ ráster como entrada para calcular la distancia en 

metros desde cada celda hacia las fuentes hídricas más cercana. 

Figura 68 

Ponderación binaria (0,1) del criterio de fuentes hídricas mediante Map Algebra 

(Raster Calculator) 

Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Map Algebra → 

Raster Calculator; se reclasificó el raster de distancia euclidiana con la expresión tipo Con 

(“Rios_ distance" > 500 mts,1,0). para obtener áreas aptas (1) y no aptas (0) según el umbral 

definido. 
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Figura 69 

Recorte del ráster de distancia hídrica y el limite distrital 

 
Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Extraction → Extract 

by Mask (CC3- limite distrital pichari); se utilizó el límite distrital de Pichari como 

máscara para delimitar el área de análisis, extrayendo únicamente la zona correspondiente 

al ámbito de estudio y optimizando los resultados del criterio de red hídrica en la 

evaluación multicriterio. 
 

Criterio 4: Áreas Naturales Protegidas por el Estado (ANPs) 

Figura 70 

Análisis del criterio de Áreas Naturales Protegidas (ANP). 
 

 
Nota. Procesos realizados: Geoprocessing → Union; se integraron las capas Áreas 

Naturales Protegidas (ANP) y Límite Distrital, generando una capa combinada que 

permitió identificar las zonas de superposición. Posteriormente, se codificó el campo 

grd_code, asignando el valor 0 para áreas no aptas (dentro de las ANP) y 1 para áreas 
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aptas (fuera de las ANP). 

 

Figura 71 

Conversión del criterio de Áreas Naturales Protegidas (ANP) a formato ráster. 

 

 
Nota. Procesos realizados: ArcToolbox → Conversion Tools → To Raster → Polygon to 

Raster; se utilizó la capa resultante del proceso Union (ANP - Límite Distrital) como 

entrada, tomando el campo grd_code como atributo de conversión. Se generó un raster 

binario donde el valor 0 representa áreas no aptas (dentro de las ANP) y el valor 1 áreas 

aptas (fuera de las ANP), dentro del análisis de ponderación binaria (0,1) de la evaluación 

multicriterio. 

 

Criterio 5: Vías de acceso 

Figura 72 

Conversión de la capa de vías de acceso a formato ráster. 

 
Nota. Procesos realizados: ArcToolbox → Conversion Tools → To Raster → Polyline to 

Raster; se utilizó la capa vectorial de vías de acceso (carreteras) como entrada, asignando 



122 

 

 

el campo de identificación correspondiente para generar un ráster lineal. 

 

Figura 73 

Cálculo de la distancia euclidiana de vías de acceso 

 

 
Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Distance → 

Euclidean Distance; se empleó el raster de vías de acceso (Vías_raster) como capa de 

entrada para generar un mapa continuo de distancias en metros desde cada celda hacia la 

vía más cercana. 

 

Figura 74 

Ponderación binaria (0,1) del criterio de vías de acceso  

 

 
Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Map Algebra → 

Raster Calculator; se utilizó el raster de distancia euclidiana a vías de acceso 

(Vías_distance) como capa de entrada, aplicando la expresión Con ("Vías_distance" > 

500, 1, 0) para reclasificar las celdas según su proximidad a las vías. El valor 1 representa 
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áreas aptas (mayor a 500 m de distancia) y 0 áreas no aptas (menor o igual a 500 m), de 

acuerdo con el criterio de accesibilidad dentro de la evaluación multicriterio. 

Figura 75 

Recorte del ráster ponderado del criterio de vías de acceso 

 

 
Nota. Elaboración propia. Proceso: ArcToolbox → Spatial Analyst Tools → Extraction 

→ Extract by Mask; se utilizó el ráster ponderado de vías de acceso como capa de entrada 

y el Límite Distrital de Pichari como máscara de recorte, con el fin de delimitar el análisis 

al ámbito territorial del distrito. 

 

Criterio 6: Áreas urbanas 

Figura 76 

Conversión de la capa de centros urbanos a formato ráster 

 
Nota. Procesos realizados: ArcToolbox → Conversion Tools → To Raster → Point to 

Raster; se utilizó la capa vectorial de centros urbanos (puntos representativos de 
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asentamientos poblados) como entrada, tomando el campo de identificación 

correspondiente para generar un ráster. 

 

Figura 77 

Cálculo de la distancia euclidiana a centros urbanos 

 

 
Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Distance → 

Euclidean Distance; se empleó el raster de centros urbanos como capa de entrada para 

generar un mapa de distancias en metros desde cada celda hacia el centro urbano más 

cercano. 

 

Figura 78 

Ponderación binaria (0,1) del criterio de centros urbanos 

 

 
Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Map Algebra → 

Raster Calculator; se utilizó el raster de distancia euclidiana a centros poblados 
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(ccpp_distance) como capa de entrada, aplicando la expresión con ("ccpp_distance" >= 

500, 1, 0) para reclasificar las áreas según su proximidad a los centros urbanos. 

 

Figura 79 

Recorte del ráster ponderado del criterio de centros urbanos. 

  
Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Extraction → Extract 

by Mask; se utilizó el raster resultante del análisis de distancia a centros urbanos como 

capa de entrada y el Límite Distrital de Pichari como máscara de recorte. Este paso 

permitió delimitar las zonas clasificadas como aptas (valor 1) y no aptas (valor 0) dentro 

del ámbito distrital. 

 

Criterio 7: Aeródromo  

Figura 80 

Conversión de la capa de áreas de aeródromo a formato ráster 
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Figura 81 

Mapa de distancia euclidiana generado a partir de la capa del Aeródromo de Pichari 

 

 
Nota. Procesos realizados: ArcToolbox → Spatial Analyst Tools → Distance → 

Euclidean Distance; se utilizó la capa raster del Aeródromo de Pichari como entrada para 

calcular la distancia en metros desde cada celda hacia la infraestructura aeroportuaria. 

 

Figura 82 

Ponderación binaria (0,1) del criterio según distancia al aeródromo Pichari 

 

 
Nota. Elaboración propia. Proceso: ArcToolbox → Spatial Analyst Tools → Map Algebra 

→ Raster Calculator; se aplicó la expresión "aero_distance" >= 13000, asignando valor 

1 (apta) a las áreas ubicadas a más de 13 km del aeródromo, y 0 (no apta) a las zonas 

menores de 13 km. 
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Figura 83 

Recorte del ráster ponderado del criterio de aeródromo. 

 

 
Nota. Elaboración propia. Proceso: ArcToolbox → Spatial Analyst Tools → Extraction 

→ Extract by Mask; se utilizó el límite distrital de Pichari como capa de máscara y el 

raster del criterio de distancia al aeródromo como capa de entrada. 

 

Criterio 8: Áreas agrícolas  

 
Figura 84 

Proceso de unión entre el límite distrital de Pichari y las áreas agrícolas 

 
Nota. Elaboración propia. Se accedió al menú Geoprocessing → Union, seleccionando 

como capas de entrada (Input Features) el Límite Distrital de Pichari y las Áreas 

Agrícolas. Esta herramienta permitió combinar ambas capas vectoriales en una sola, 
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conservando todos los atributos espaciales y temáticos. 

 

 

Figura 85 

Edición y codificación del criterio de áreas agrícolas tras la unión con el límite distrital 

 

 
Nota.  Luego de realizar la unión (Union) entre las áreas agrícolas y el límite distrital de 

Pichari, se procedió a la edición de la tabla de atributos utilizando Editor → Start Editing 

→ Merge.Este proceso permitió agrupar los diferentes tipos de cultivos agrícolas (café, 

cacao y piña) en una sola categoría denominada “Áreas agrícolas”, considerando su 

función común dentro del territorio. 

  

Figura 86 

Edición y codificación del criterio de áreas agrícolas tras la unión con el límite distrital 

 

 
Nota. Procesos realizados: ArcToolbox → Conversion Tools → To Raster → Polygon to 

Raster; se utilizó la capa resultante del proceso Union2 (Áreas agrícolas - Límite Distrital) 

como entrada, tomando el campo grd_code como atributo de conversión. Se generó un 
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ráster binario donde el valor 0 representa áreas no aptas (dentro de áreas agrícolas) y el 

valor 1 áreas aptas (fuera de las Áreas agrícolas), dentro del análisis de ponderación 

binaria (0,1) de la evaluación multicriterio. 

 

Figura 87 

Multiplicación de los criterios para el modelo final de sitios óptimos para relleno 

sanitario. 

 

 
Nota. La figura muestra la integración final de los criterios temáticos evaluados (C1, C2, 

C3, C4, C5, C6, C7 y C8) mediante la herramienta Raster Calculator. Se realizó una 

superposición lógica booleana, donde los valores 1 (apto) y 0 (no apto) fueron 

multiplicados para determinar las áreas que cumplen simultáneamente todas las 

condiciones de aptitud para la localización del relleno sanitario. 


